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POLAR INSTRUMENTS LTD. HARDWARE WARRANTY 

 
1. Product Warranty.  Product hardware is warranted to be free from defects in material and 

workmanship during the Warranty Period (as defined below). Product hardware is warranted to 
conform substantially to Polar’s then current (as of the date of Polar’s product shipment) published 
user documentation during the Warranty Period. The Warranty Period is twelve (12) months. Product 
support beyond these periods may be available at additional cost – consult Polar for details 

TDR Head and Input Relay warranty 
This product is an extremely sensitive measuring instrument. To prevent damage it is essential to 
observe static precautions at all times. The TDR head and/or input relay will be damaged if any 
voltage (e.g. from static) is applied to the probes. 
The warranty period for the TDR head is six (6) months or until one failure, whichever occurs sooner.  

The warranty period for the relay is one year or 1 million operations, whichever occurs sooner.   

Reliability statistics indicate that if the TDR head and/or the relay’s input resistor have been 
damaged, it is likely to have arisen from misuse (e.g. static damage or similar) and as these 
circumstances are outside Polar Instruments’ control, any further failures will not be covered by 
warranty.  

2. Warranty Claims.  Polar shall incur no liability under this warranty if the end user fails to provide 
Polar with notice of the alleged defect during the applicable Warranty Period and within seven (7) 
days of delivery to end user or, if the defect would not have been reasonably apparent on inspection, 
within seven (7) days of its discovery by end user. After receiving such notice, Polar will notify the 
purchaser of its designation of one of the following problem resolution methods: 
Return to Factory: The allegedly defective goods must be returned to Polar within seven days of 
Polar’s notice and in accordance with Polar’s instructions advised at the time. 
Other:  Polar will use commercially reasonable efforts to repair, correct or work around the problem 
by means of telephone support or other means reasonably determined by Polar. 
Polar shall incur no liability under this warranty if Polar’s tests disclose that the alleged defect is due 
to causes not within Polar’s reasonable control, including alteration or abuse of the goods. Under the 
Return to Factory alternative, if a Product is determined not to be defective or to have a defect due to 
causes not within Polar’s reasonable control, Polar reserves the right to apply a processing charge. 

3. Damage in Transit.  End user must notify Polar and the carrier of any claim for damage in transit 
within two (2) days of receipt of the damaged merchandise. Failure to do so may result in the carrier 
and/or Polar refusing to accept liability in which case end user must pay the purchase price as if the 
hardware had been delivered without damage. 

4. Polar’s Liability Polar’s liability, and end user’s sole and exclusive remedy, shall be limited to the 
express remedies set forth in this Polar Hardware Warranty. 

5. Disclaimer of Warranties.  POLAR MAKES NO OTHER WARRANTIES, EXPRESS, IMPLIED 
OR STATUTORY, REGARDING PRODUCTS. ALL OTHER WARRANTIES AS TO THE QUALITY, 
CONDITION, MERCHANTABILLITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT ARE EXPRESSLY DISCLAIMED. 

6. Limitation of Liability.  POLAR SHALL NOT BE RESPONSIBLE FOR DIRECT DAMAGES IN 
EXCESS OF THE PURCHASE PRICE PAID BY THE END USER OR FOR ANY SPECIAL, 
CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGE, INCLUDING, BUT NOT LIMITED TO, 
LOSS OF PROFITS OR DAMAGES TO BUSINESS OR BUSINESS RELATIONS, WHETHER OR 
NOT ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES, THE FOREGOING 
LIMITATIONS SHALL APPLY, NOTWITHSTANDING THE FAILURE OF ANY EXCLUSIVE 
REMEDIES. 

Copyright Polar Instruments Ltd. © 2024 

Microsoft®, Windows®, and Windows 10® are registered trademarks of Microsoft Corporation. 

IBM® is the registered trademark of International Business Machines Corporation. 
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DECLARATIONS 

EUROPEAN COMMUNITY DIRECTIVE CONFORMANCE STATEMENT 

Product: CITS880, CITS880s 
 
This product conforms to all applicable EC Council Directives, including: 
 

EC Council Directive 2014/30/EU (commonly referred to as “the EMC Directive”) on the 
approximation of the laws of the Member States relating to electromagnetic compatibility. 
 
EC Council Directive 2014/35/EU (commonly referred to as the LVD Directive”) on the 
harmonisation of the laws of the Member States relating to electrical equipment designed for use 
within certain voltage limits. 
 
EC Council Directive EC 1907/2006 as amended by 2015/863/EU (commonly referred to as “the 
RoHS 3 Directive”) on the Registration, Evaluation, Authorisation and Restriction of Chemicals 
(REACH) as regards skin corrosion/irritation, serious eye damage/eye irritation and acute toxicity 
 
EC Council Directive 2012/19/EU (commonly referred to as “the WEEE Directive”) on waste 
electrical and electronic equipment. 

 
Harmonised standards applied in order to verify compliance with these Directives: 
 

EN 61326:1998 
EN 61010-1:2010 

 
The CE-mark was first applied to this product in 2014. 
 
The manufacturer of this product takes full responsibility for this declaration of conformity:  
 

Polar Instruments Ltd 
Garenne Park 
St Sampsons 
Guernsey 
GY2 4AF 

 
Signed for Polar Instruments Ltd: 
 

  
 
  Nigel A. Mann (Director) 
 
 
This declaration issued 07/04/2021. 
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SAFETY 

WARNING 
The LIVE and NEUTRAL lines on this unit are BOTH fused. 
This unit contains no user-serviceable parts. When the unit is 
connected to its supply, the opening of covers or removal of 
panels is likely to expose dangerous voltages. To maintain 
operator safety, do not operate the unit unless the enclosure 
is complete and securely assembled. 

GROUNDING 
This unit must be earthed (grounded); do not operate the 
instrument with the safety earth disconnected. Ensure the 
instrument is connected to an outlet with an effective 
protective conductor terminal (earth). Do not negate this 
protective action by using an extension cord without a 
protective conductor. 
Note: This instrument is fitted with 3-wire grounding type plug 
designed to fit only into a grounding type power outlet. If a 
special local plug must be fitted to the power cord ensure this 
operation is performed by a skilled electronics technician and 
that the protective ground connection is maintained. The plug 
that is cut off from the power cord must be safely disposed 
of. 
Power cord color codes are as follows: 
Europe 
 brown  live 
 blue  neutral 
 green/yellow earth (ground) 
 
United States 
 black  live 
 white  neutral 
 green  ground 

POWER SUPPLY 
Check that the indicated line voltage corresponds with the 
local mains power supply. See the rear panel for line voltage 
range and frequency. 
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CITS880s OPERATION 
This manual contains instructions and warnings that must be 
observed by the user to ensure safe operation. Operating 
this instrument in ways other than detailed in this manual 
may impair the protection provided by the instrument and 
may result in the instrument becoming unsafe. Retain these 
instructions for later use. 
Use only the precision cables supplied by Polar Instruments; 
the CITS880s is calibrated using the supplied Polar cables. 
Use of any other cables or exchanging cables between 
channels may invalidate the calibration of the unit. 
The instrument is designed for use indoors in an electrical 
workshop environment at a stable workstation comprising a 
bench or similar work surface. Use only the accessories (e.g. 
test probes and cables) provided by Polar Instruments. The 
unit must be maintained and repaired by a skilled electronics 
technician in accordance with the manufacturer’s instructions. 
The instrument should not be installed in such a way as to 
inhibit access to the mains switch on the rear panel. This 
switch or the removal of the power connector are the prime 
means of disconnection from the supply in an emergency. 
If it is likely that the protection has been impaired the unit 
must be made inoperative, secured against unintended 
operation and referred to qualified service personnel. 
Protection may be impaired if, for example, the instrument: 

Shows signs of physical damage 
Fails to operate normally when the operating instructions 
are followed 
Has been stored for prolonged periods under unfavourable 
conditions 
Has been subjected to excessive transport stresses 
Has been exposed to rain or water or been subject to liquid 
spills 

CAUTION 

Electrical Isolation 
Always disconnect the board under test from the local mains 
supply (including ground) before using this instrument. The 
CITS880s applies test voltages to the item under test. Make 
sure that the item under test is isolated from all other sources 
of electrical power. External power could damage the tester. 

Static sensitive devices 
This unit contains static sensitive devices. Observe static 
precautions at all times. 
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SPECIFICATIONS 

Test parameters 
Controlled Impedance Measurement Range 20 – 150Ω (single-ended) 

40 – 200Ω (differential) 
70 – 130Ω (groundless differential) 

Measurement Accuracy (single-ended) 
Calibrated against traceable airline 
standards at 28Ω, 50Ω, 75Ω and 100Ω 

± 1.5% at 28Ω 
± 1% at 50Ω 
± 1.25% at 75Ω 
± 1.5% at 100Ω 

Measurement Accuracy (differential, typical) 
Typical values for even mode Zoe < 100Ω. 
For 100Ω < Zoe< 150Ω add 1%. 
For 150Ω < Zoe< 180Ω add 1.5%. 

± 2.5% at 56Ω 
± 2% at 100Ω 
± 2.5% at 150Ω 
± 3% at 200Ω 

Measurement Accuracy (groundless 
differential) 

± 3% at 100Ω 
± 4% at 70Ω/130Ω 

Impedance Tolerance Range 0.1% – 99.99% 

Vertical Display Ranges (Ω) 1, 2, 5, 10, 20, 50Ω/division 

Vertical Display Ranges (mRho) 10, 20, 50, 100, 200, 500 mRho/division 

Horizontal Display Ranges Automatically set by software 

Testable Trace Lengths 
Optimum 
Minimum (using non-matched probe) 
Minimum (using matched probe) 
Maximum 

 
0.15 meters 
0.09 meters 
0.05 meters 
2 meters 

Horizontal Distance Units Inches, feet, meters, millimeters 

Horizontal Time Units Nanoseconds, picoseconds 

Test Method Time Domain Reflectometer (TDR 
measurement using PC software control) 

Reflected Pulse Risetime ≤ 200ps 

System Bandwidth >1.75 GHz (derived from maximum risetime) 

Output Impedance  50Ω (± 2%) 

Pulse Amplitude Nominal 300mV into 50Ω load 

Calibration Method 
 

Ratiometric measurement to calibrated 
precision internal 50Ω reference 

Vp Compensation 0.33 – 0.99 

Relay Life 1 x 106 operations/channel (typical) 

Channels 4 
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ENVIRONMENTAL OPERATING CONDITIONS 

The instrument is designed for indoor use only under the 
following environmental conditions: 
 

Altitude Up to 2000m 

Temperature +10°C to +30°C ambient 

Relative humidity RH 80% maximum at 31°C — derate 
linearly to 50% at 40°C 
Non condensing. 

Mains borne transients As defined by Installation Category II 
(Overvoltage Category II) in 
IEC60364–4–443 

Pollution Degree 2 

 

POWER REQUIREMENTS 
85 – 250V at 50/60Hz (0.1 – 0.06A) 

Line Fuse values 
Time Delay 1.6A T 

PHYSICAL CHARACTERISTICS (EXCLUDING ACCESSORIES) 
Temperature 

Operating 10°C to 30°C 
Storage 0°C to +50°C 

Dimensions  
Width 446 mm (17.6 in.) 
Height 132 mm (5.2 in.) 
Depth 300 mm (11.81 in.) 
Weight 6.9kg (15.2 lb.) 
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SYMBOLS 

  CAUTION 
No external voltage should be applied to the front panel 
SMA connector terminals. Read Section 2 — SETTING 
UP THE CITS880s SYSTEM for information on how to 
use these connectors. 
On the rear panel the USB connector should be used to 
link to the controlling PC using the cable provided.  
See installation sheet.  
The Status port D connector should be used in 
accordance with the instructions in Appendix C. 
 

  CAUTION 
Static sensitive devices — observe electrostatic discharge 
precautions. A wrist strap is provided with the CITS880s 
(connect the wrist strap to one of the sockets on the 
CITS880s front panel). 
 
Note: The CITS880s contains static sensitive devices — 
observe electrostatic discharge precautions at all times. 

PERSONAL COMPUTER REQUIREMENTS 

Computer IBM PC or compatible 
Processor Pentium 1.6GHz or better 
Operating system Windows 10 or later 
System memory required 2 GB recommended 
Hard disk space required 20 MB (min.) 
Video standard FHD (1920 x 1080 min.) 
Communication ports 2 available USB 2.0 ports required 



CITS880s User Guide ACCESSORIES  •  vii 

ACCESSORIES 

Standard Accessories 
Probe Cable WMA360 
IPS-50 Microstrip Probe (50Ω) CPB001 
IPDS-100 Differential Probe (100Ω) CPB274 
Sample Test Coupon MPCD1325 
Operator manual MAN207 
USB 2.0 cable ACC371 
Foot Switch ACC383 
Antistatic wristband ACC175 
Wrist band ground cord ACC185 
50 ohm reference impedance WMA328 
Torque wrench ACC313 
SMA Adaptor MQX428 

Optional Accessories 
Instrument carrying case ACC125 
Datalog Report Generator (DRG Pro) ACC230 
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GUIDE TO THE MANUAL 

 
INTRODUCTION An overview of the Polar CITS880s. 

A description of the principles of operation and 
explanation of basic TDR principles and controlled 
impedance. 

INSTALLATION/SET UP Connecting the instrument to a power supply, 
installation of software and preparation for use. 
 
Specifying the PC communication ports, calibration 
type and passwords. 

GETTING STARTED Introduction to basic CITS880s operation using the 
supplied sample test coupons. 
Using the Setup Wizard (first time users.) 

OPERATION Operation of the CITS880s. Information about the 
different ways in which the facilities of the CITS880s 
can be used and how to test boards. 

THE TEST FILE EDITOR Description of test parameters – creating, writing and 
saving test files. 

MAINTENANCE Details of maintenance and cleaning procedures. 

APPENDIX A Notes on Characteristic Impedance. 

APPENDIX B Notes on static sensitive devices and preventing 
damage to the CITS. 

APPENDIX C Status output connector details 
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OPERATING THE CITS880s 

The CITS880s software is designed for use within the 
Microsoft Windows® environment. Familiarity with the 
Microsoft Windows 10® or later environments is assumed. 
For more information on Microsoft Windows® operation 
consult the appropriate Microsoft Windows® User Guide. 
CITS880s functions are controlled by selecting the 
associated commands from pull-down menus or clicking the 
“short-cut” buttons with the mouse. 

Selecting commands 

Using the keyboard: 
Activate the CITS880s menu bar by pressing the Alt key on 
the keyboard. Use the arrow keys to navigate to the 
commands. Press <Enter> or <CR> to accept or the <Esc> 
key to cancel. 

Using the mouse: 
To display a command list, point to the menu name and click 
the left mouse button. 
Point to the command name and click the left mouse button. 
Selecting a command name which is followed by ellipses (...) 
displays a dialog box containing options which qualify the 
command. 
Clicking the OK button corresponds to pressing the <CR> or  
<Enter> key on the keyboard. 
Clicking the Cancel button corresponds to pressing the 
<Esc> key on the keyboard. 
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SECTION 1 — INTRODUCTION 

CONTROLLED IMPEDANCE TESTING 

1-1 The CITS880s system 
The CITS880s Controlled Impedance Test System is 
designed to provide low cost automated measurements of 
the characteristic impedance of printed circuit boards and 
test coupons. The system is shown in the diagram below. It 
should only be used on un-powered PCB samples in 
accordance with the instructions in this manual. 

 
Figure 1-1 CITS880s Controlled Impedance Test System 

The Polar Instruments Controlled Impedance Test System 
comprises a measurement system controlled by software 
running within the Microsoft Windows® environment on an 
IBM PC-compatible computer. 
The CITS880s is designed to facilitate rapid and convenient 
testing of single-ended and differential controlled impedance 
printed circuit board traces and test coupons. 
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Figure 1-2 CITS880s Waveform Display Window 

Connection between the CITS880s and boards under test is 
achieved using the special Polar supplied microstrip probes 
and probe cables. 

 

CITS880s probes 
Polar produces a comprehensive range of test probes with a 
wide choice of footprints, Test probe types include: 

• single ended – IPS 

• differential – IPDS 

• groundless differential – GDPS probes 
and are precision molded from ESD dissipative materials and 
include internal ESD grounding. For maximum protection 

https://www.polarinstruments.com/products/probes/probe_index.html
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against ESD damage Polar also recommends operators use 
a wrist strap connected to an appropriate ESD ground point. 

CITS880s software 
The CITS880s software is written to run within the Microsoft 
Windows® environment, so test result waveforms may be 
printed out using the currently installed printer. 
The CITS880s system may be controlled from the PC 
keyboard or by simple point-and-click operations with a 
Microsoft-compatible mouse. Use of a mouse is 
recommended for maximum ease of use. 
A plug-in foot-switch is included with the CITS880s to allow 
the operator to perform hands-off testing. 

1-2 Test files 
All the information necessary for performing a controlled 
impedance measurement on a circuit board is stored in a test 
file. An operator only needs to select the appropriate test file 
from a list and the system is ready for testing. 
Test files are easily created and modified via the integrated 
test file editor — most files will be created with just a few key-
strokes and mouse clicks. Test files provide a convenient 
mechanism for automated testing of boards with a number of 
different controlled impedance traces. 
Test files in may be imported in XML format to support 
Industry 4 automation and data exchange. 

1-3 Data analysis 
Test results are displayed as a graph of impedance against 
distance or time along a PCB track. PASS, INTERMEDIATE 
or FAIL results are returned according to whether or not the 
impedance of the trace remains within tolerance over the full 
length of the tested region, using a range of test methods. 
The average, standard deviation, minimum and maximum 
impedance values over the tested region are displayed on 
screen along with the measured waveform; differential test 
results include readings for odd and even mode impedances, 
crosstalk and unbalance. 
The CITS880s supports launch point extrapolation (LPE) 
which uses line fitting to the TDR trace. LPE can better 
reflect the impedance that the signal sees as it launches into 
the trace. 
All test results are displayed on the PC screen in waveform 
and statistical form for rapid analysis. Waveforms may also 
be stored to disk for later inspection. 
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Test data may be logged for subsequent statistical analysis. 
The stored data may be printed out or imported into a 
spreadsheet or the Datalog Report Generator (available as 
an optional accessory.) 
The CITS880s also generates data in delimited format 
(suitable for importing into a spreadsheet or database) for 
statistical process control (SPC) analysis. 
Test results (with user-selectable data columns) may be 
exported in Microsoft Excel® format. 

1-4 CITS880s features 
The CITS880s system is designed to make the complex 
process of impedance testing as simple as possible. The 
CITS880s includes the following features: 

Board testing 
Four channel testing. 
Average, absolute and envelope test methods support 
measurement of a comprehensive range of impedance 
values, including average, standard deviation, minimum, 
maximum and (maximum – minimum) readings for single-
ended, differential and groundless differential testing, odd and 
even modes, crosstalk and unbalanced lines. 
Imbalance between lines is measured and logged in 
differential tests. A warning is issued when the imbalance 
exceeds operator-specified level. 
Wide range of Polar Instruments manufactured microstrip 
probes for easy connection to the board under test. The IPS, 
IPDS and GDPS probes are precision molded from ESD 
dissipative materials and include internal ESD grounding 
Automatic instrument set up 
Setup Wizard for first time users 
Integrated test file editing 
Group testing for verification of impedance spread 

Data logging 
Rapid data logging of test results 
Statistical analysis for process control 
Automatic storage of waveforms/test results 
Automatic storage of file snapshots 
Hard copy of test & stored results 
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Display 
Linear display of impedance against distance (in U.S. or 
metric measurements) or time. 

 
Figure 1-3 CITS880s Main screen 

Impedance display in Ohms or mRho 
Differential impedance measurements incorporate optional 
on-screen single-ended and odd and even mode impedance 
waveforms for engineering analysis 
On-screen cursors for easy distance measurement 
On-screen display of waveform statistical analysis 
Clear Pass/Intermediate/Fail PCB track test results displayed 
in waveform window 
Waveform overlay for rapid comparison of results 
Impedance measurement using absolute, average or 
envelope test methods 
User definable colour schemes 

Status Outputs 
The CITS880s includes opto-isolated, open-collector Status 
Outputs (located on the rear of the CITS) to provide a 
hardware indication of the results of a test. See Appendix C 
for connector details. 
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Statistical Process Control 
The CITS880s provides the facility to log continuously all data 
to an external file. The file is in delimited text format so can be 
easily imported into and edited by a spreadsheet or database 
and includes fields that can be used by statistical process 
control systems. 

1-5 Characteristic impedance 
As the speed of electronic devices increases the electrical 
properties of the circuits carrying signals between them 
become more important. 
At the high frequencies and clock rates of modern digital 
circuitry, cables and PCB tracks cannot be regarded as 
simple connections but should be considered by the PCB 
designer as transmission lines to ensure that signals are not 
degraded as they route around the PCB. 
In the case of PCB tracks the series resistance and parallel 
conductance of the transmission lines are largely negligible. 
The most significant circuit parameters governing PCB trace 
performance are the distributed series inductance and 
parallel capacitance of the conductors; the impedance of a 
PCB trace will be determined by its inductive and capacitive 
reactance. 
These parameters give rise to the characteristic impedance, Z0, 

𝑍𝑍0 = �𝐿𝐿
𝐶𝐶 

where L is in henrys per unit length, C is in farads per unit 
length and Z0 is in ohms. Trace impedance will depend on 
the physical dimensions of the trace (e.g. trace width and 
thickness) and the dielectric constant of the PCB substrate 
material and dielectric thickness. PCB impedances will 
typically range from 25 to 120 ohms. 
Consider an electrical signal travelling through a conductor 
such as a PCB track.When the signal encounters a change 
of impedance (Z0) arising from a change in material or 
geometry, part of the signal will be reflected and part 
transmitted. These reflections are likely to cause aberrations 
on the signal that may degrade circuit performance. 
To optimise performance of high-speed circuits it is desirable 
to match the input and output impedances of devices with 
the characteristic impedance of the interconnections. 
See Appendix A for a more detailed discussion of 
characteristic impedance. 
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1-6 TDR fundamentals 
The CITS880s Controlled Impedance Test System makes 
measurements using time domain reflectometry (TDR). 

Time domain reflectometry 
A time domain reflectometer is a special kind of oscilloscope. 
A “normal” oscilloscope measures changes in voltage over a 
period of time and displays this as a graph. A TDR performs 
a similar function but incorporates additional circuitry to 
output a voltage and monitor changes in that voltage level 
over a period of time. 
Time domain reflectometry is similar in principle to radar or 
sonar in that a signal is transmitted and the reflections or 
echoes of that signal are monitored. In the case of TDR the 
signal is a voltage transmitted along a cable or PCB track. 
Reflections of the signal occur when there is a change in the 
characteristic impedance of the conductor. The time taken for 
the reflections to return to the TDR can be used to measure 
the distance to any change in impedance. 

 

Figure 1-4 Simplified TDR-cable system equivalent circuit 
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The diagram below shows a typical TDR waveform. 

 
Figure 1-5 TDR trace showing voltage steps at impedance discontinuities 

As a step wave propagates down a cable any increase in 
characteristic impedance causes a reflected voltage which 
adds to the initial step. 
This is shown, for example, in the previous diagram by the 
step up from the 50Ω to 75Ω cable. 
A decrease in impedance would cause a reflection in the 
opposite sense which would show as a downward step in the 
TDR trace. As long as the characteristic impedance remains 
constant the trace remains level. 
An open circuit at the end of the cable reflects 100% of the 
voltage in a large upward step. 
If the end of the cable were to be short circuited a 100% 
reflection in the opposite direction would occur, returning the 
trace to the zero voltage level. 
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1-7 CITS880s measurements 
The CITS880s displays a graph of the characteristic 
impedance of a specified length of PCB trace. 
This is achieved by calculating the impedance along the 
length of the cable or PCB based on the size of the 
reflections measured using time domain reflectometry. 

Single ended impedance testing 
Normal controlled impedance structures comprise a single 
signal conductor and a ground plane or planes. Impedance 
measurements made between the signal and ground are 
sometimes referred to as single-ended. 
The single-ended transmission line is probably the 
commonest way to connect two devices. In this case a single 
conductor connects the source of one device to the load of 
another device. 
The circuit below is an example of a single-ended 
transmission line. 

 

Figure 1-6 Single ended transmission line 

The reference (ground) plane provides the signal return path. 
This is an example of an unbalanced line. The signal and 
return lines differ in geometry — the cross-section of the 
signal conductor is different from that of the return ground 
plane conductor. 
The impedance of a PCB trace will be determined by its 
inductive and capacitive reactance, resistance and 
conductance. These will be a function of the physical 
dimensions of the trace (e.g. trace width and thickness) and 
the dielectric constant of the PCB substrate material and 
dielectric thickness. PCB impedances will typically range 
from 25 to 120 ohms.  

Single-ended transmission lines on PCBs 
In practice, a single-ended PCB transmission line typically 
consists of a line conductor trace, one or more reference 
planes and a dielectric substrate comprising one or more 
layers of dielectric material. Two configurations are 
commonly used, microstrip and stripline. 

Controlled
impedance

A B
Input Output

Terminating 
Resistance



10  •  CONTROLLED IMPEDANCE TESTING CITS880s User Guide 

Surface Microstrip 

  
Surface microstrip with single dielectric below the trace 

The simplest configuration, the surface (or exposed) 
microstrip, shown in the diagram above, consists of a signal 
line, the top and sides exposed to air, on the surface of a 
board of dielectric constant Er1 and referenced to a power or 
ground plane. 
The surface microstrip structure can be implemented by 
etching one surface of double-sided PCB material. The 
diagram illustrates the typical (cross-section) layout of the 
surface microstrip structure (using a single dielectric layer) 
and shows the characteristic microstrip impedance attributes: 

the microstrip impedance references a single plane 
the impedance trace is often on an outer layer 

The trace and plane(s) form the controlled impedance. The 
PCB will frequently be multi-layer in fabrication and the 
controlled impedance can be constructed in several ways. 
However, whichever method is used the value of the 
impedance will be determined by its physical construction 
and electrical characteristics of the dielectric material: 

the width W1, W2 and thickness T1 of the signal trace 
the height H1 of core or pre-preg material either side of 
the trace  
the configuration of trace and planes  
the dielectric constant Er1 of the core and pre-preg 
material 
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Offset stripline 
The stripline (shown in profile below) typically consists of a 
line conductor trace sandwiched between two reference 
planes and a dielectric material (shown as two layers). 

 
Offset stripline with one layer of dielectric above and below the trace 

In this configuration the signal trace is sandwiched between 
two planes and may or may not be equally spaced between 
the two planes. This construction is often referred to as dual 
stripline. 
A second mirror trace will be positioned down from the top 
ground plane. These two signal layers will be routed 
orthogonally (crossing at right angles so as to minimise the 
crossing area). 
The transmission line, i.e. the trace and planes, form the 
controlled impedance. The value of the impedance will be 
determined by its physical construction and electrical 
characteristics of the dielectric material: 

the width and thickness of the signal trace 
the dielectric constant and height of the core or pre-preg 
material either side of the trace 
the configuration of trace and planes 

Electromagnetic waves in a vacuum travel at the speed of 
light. The propagation velocity in a material is primarily 
dependent on the Er of the material and is roughly inversely 
proportional to the square root of the dielectric constant of 
the material. Assuming a value of about 4 for dielectric 
constant for G-10 or FR-4 (the actual value will depend on 
frequency and the glass to resin ratio) the propagation 
velocity will approximate to half the speed of light. 
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Coated microstrip 

 
Coated microstrip with single dielectric layer below the trace 

As in the case of the surface microstrip this construction is 
simple to fabricate, but the extra process of adding solder 
mask coating can cause impedance variations. The operator 
must specify the thickness of the coating outside, above and 
between the traces to allow for variations in the board 
fabricating process. 
This construction is particularly sensitive to solder mask 
flooding with LPI (Liquid Photo Imageable) solder mask. (In 
differential structures this causes the dielectric constant in 
the edge-coupling region to vary, depending on flood depth.) 

Differential impedance testing 
A more complex type of controlled impedance structure is 
that of a differential pair of signal conductors. The lines are 
driven as a pair with one line transmitting a signal waveform 
of the opposite polarity to the other. At the receiving end one 
signal is subtracted from the other so noise induced in both 
lines is cancelled out. This method is commonly employed to 
achieve high noise immunity in high speed digital and analog 
systems. 
The characteristic impedance of a differential pair is affected 
not only by the impedance of each line of the pair to ground 
but also by the interaction of the signal lines with each other. 
The differential configuration (often referred to as a balanced 
line) is used when better noise immunity and improved timing 
are required. In differential mode the signal and its logical 
complement are applied to the load. 
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Figure 1-7 Differential configuration – balanced line 

The balanced line thus has two signal conductors and an 
associated reference plane or planes as in the equivalent 
single-ended (unbalanced) case. Fields generated in the 
balanced line will tend to cancel each other, so EMI and RFI 
will be lower than with the unbalanced line. External noise 
will be "common-moded out" as it will be equally sensed by 
both signal lines. 

Differential transmission lines on PCBs 
A typical differential configuration, the edge-coupled surface 
microstrip is shown below. 

Edge-coupled surface microstrip 

 
Edge-coupled surface microstrip with one layer below the traces 

In this construction the gap S1 between the traces defines 
the coupling factor and hence the differential impedance. 
The etch factor, plating density and undercut will make this 
construction simple to manufacture, but with a wider 
tolerance due to the extra processing required on external 
layers. 

Controlled
impedance

A B
Input Output
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The stripline construction is also used in differential pair 
configurations. A typical construction, the edge-coupled 
offset stripline is shown below. 

Edge-coupled offset stripline  

 
Edge-coupled offset stripline with one dielectric layer  

above the traces and two below 

The reduced processing of internal layers makes this 
construction easier to fabricate with more consistent results 
than the equivalent surface trace structure. During the 
manufacturing process resin will be forced in between the 
traces resulting in a resin-rich region (shown as REr in the 
model) between the two traces. This region will consist of a 
dielectric with Er different from the rest of the structure. 

The Differential Test 
Controlled impedance structures often comprise a single 
signal conductor and a ground plane or reference plane. 
Impedance measurements made between the signal and 
ground are then sometimes referred to as single-ended. 
Where higher performance (e.g. greater noise immunity and 
better EMC performance) is required a more complex type of 
controlled impedance structure is employed — that of a 
differential pair of signal conductors. The signal lines are 
driven as a pair with one line transmitting a waveform of 
opposite polarity to the other. 
At the receiving end one signal is subtracted from the other 
so any noise induced in both lines is cancelled out. This is a 
technique commonly used to increase noise immunity (and 
reduce signal skew in bus circuitry) in high speed digital and 
analog systems. 
The characteristic impedance of a differential pair, therefore, 
is affected not only by the impedance of each line of the pair 
to ground but also by the interaction of the signal lines with 
each other. 
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The CITS880s differential tests include results for odd and 
even mode and unbalance between lines. 

Test coupons 
The impedance of a PCB trace depends on a number of 
factors, including the dimensions of the trace (i.e. trace width 
and thickness) and the thickness and dielectric constant of 
the laminate and prepreg material. It's common practice for 
board manufacturers to check controlled impedance build 
integrity initially by building engineering lots to verify copper 
weight, line widths and dielectric thickness and constant 
before beginning volume production. Even in production 
manufacturers perform 100% controlled impedance testing 
on controlled impedance boards. 
However, it is not uncommon for the actual PCB traces to be 
inaccessible for testing. In addition, traces may be too short 
for accurate measurement and will probably include 
branches and vias which would also make exact impedance 
measurements difficult. Adding extra pads and vias for test 
purposes would almost certainly adversely affect the 
performance of a controlled impedance trace as well as 
occupying valuable board space. PCB testing is therefore 
normally performed, not on the PCB itself, but on one or two 
test coupons integrated into the PCB panel. The coupon will 
be of the same layer and trace construction as the main PCB 
and will include traces with precisely the same impedance as 
those on the PCB, so testing the coupon will give a high 
degree of confidence that the board impedances will be 
correct. 
The CITS880s is supplied with a sample coupon with single 
ended and differential traces, typical of those used in 
manufacturing, with the associated test files so that users 
may familiarise themselves with the operation of the 
instrument. 
 



 

16  •  SETTING UP THE CITS880s SYSTEM CITS880s User Guide 

SECTION 2 — INSTALLATION AND SET UP 

SETTING UP THE CITS880s SYSTEM 

Siting the CITS880s 
The CITS880s should be installed indoors on a stable, level 
bench or workstation in an environment as described in the 
SPECIFICATIONS section. 
The host PC should be sited adjacent to the CITS880s and 
its monitor and keyboard positioned at heights suitable for 
comfortable operation. 
When assigning a work area for the testing of PCBs and 
positioning equipment, consideration should be given to the 
probe cables and how they flex. See Figure 1-1 for typical 
workstation layout. 

System requirements 
The CITS880s software is designed to run on a personal 
computer meeting the following specifications: 
 

Computer IBM PC or compatible 
Processor Pentium 1.6GHz or faster 
Operating system Microsoft Windows 7 or later 
System memory required 1GB (32- bit) 2GB (64-bit) 
Hard disk space required 20 MB 
Video standard FHD (1920 x 1080) or higher 

recommended 
Communication ports 2 USB 2.0 ports required 

2-1 Unpacking 
The instrument is shipped in a sturdy transit pack. 
Open the pack carefully and remove the instrument and its 
accessories. If the instrument is damaged in any way contact 
the local distributor or supplier. 
Retain the pack for possible future use. 
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Note: Always obtain a Return Number before returning an 
instrument to Polar Instruments. 
The package should contain: 
 Installation sheet 

CITS880s 
 50Ω probe cables (x4) 
 IPS50 Microstrip probe 
 IPDS100 Differential Probe 
 Sample test coupon 
 Power cord 
 USB 2.0 interface cable 
 Foot switch 
 Accessory pouch 
 Program installation disk / Operator Manual 
 Anti-static wrist band and cord 
Note: If the instrument has been shipped or stored in a cold 
environment, allow the instrument to reach the temperature 
of its new location before applying power. 

2-2 Controls and connectors 

SMA connectors 
The Front Panel SMA connectors should be connected to 
Polar Instruments microstrip probes only. 
Caution: Tighten with care. Use a torque wrench set to 5 lbf 
inches ±0.3 lbf inches (0.565 Nm ±0.034Nm). 

USB interface to the PC 
Important! Install the CITS880s and USB driver software 
prior to connecting the CITS880s to the host computer via 
the supplied USB 2.0 cable. 

Status 
Connections to the 9-pin D Status output are to be made as 
instructed by trained and qualified technicians in accordance 
with the information in the Service Manual. See Appendix C 
for Status connection details. 

Footswitch 
Connect to a free USB port on the PC. 
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Microstrip probes 
The IPS single ended probes, IPDS differential probes and 
GDPS groundless differential probes are precision moulded 
from ESD dissipative materials and include internal ESD 
grounding. (For maximum protection against ESD damage 
Polar also recommends that operators use a wrist strap 
connected to an appropriate ESD ground point.) 

Wrist strap/Ground 
The wrist strap socket provides a connection to the 
machine’s enclosure; it is connected directly to the protective 
conductor of the supply cord. This connector should only be 
used for antistatic wrist straps. 

Connecting to a power supply 
WARNING! Do not locate the instrument in such a way 
as to prevent access to the power switch. 
Refer to the voltage label on the rear panel of the 
instrument and make sure that the marked voltage range 
is suitable for the local mains power supply. 
Note: If a special local plug must be fitted to the power cord 
ensure this operation is performed by a skilled electronics 
technician and that the protective ground connection is 
maintained. The plug that is cut off from the power cord must 
be safely disposed of. 
Power cord colour codes are as follows: 
Europe 
 brown live 
 blue neutral 
 green/yellow earth (ground) 
United States 
 black live 
 white neutral 
 green ground 
Connect the power cord to the instrument and to the power 
source. 
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2-3 Installing the CITS880s software 

Installing the program 
Important! 
Install the CITS880s and USB driver software prior to 
connecting the CITS880s to the host computer via the 
supplied USB 2.0 cable. The USB driver will be installed 
when the CITS880s is powered up connected to the host 
computer. 
Close all other programs. 
Log on to the computer as an administrator. 
Navigate to the Polar software release page supplied (contact 
polarcare@polainstruments.com for the latest version.) 
After downloading the software, unpack the software into a 
suitable folder and run Setup.exe from there. Follow the 
instructions on screen. 

Choosing the install folder 
The CITS880s Installation program proposes the destination 
location — the drive and folder of the hard disk onto which the 
CITS880s program is to be installed, by default: 
C:\Program Files\Polar\CITS880s on a 32-bit system, 
C:\Program Files (x86)\Polar\CITS880s on a 64-bit system. 
Press <Continue> to accept the proposed destination drive 
and folder or type the name of an alternative drive and folder. 
To choose an existing drive and folder (directory) press the 
Choose Directory button — the Choose Directory dialog box is 
displayed. 
Navigate to the destination directory from the Choose 
Directory box and press OK. Press <Continue>. 
The Installation program will prompt for a name for the 
CITS880s program group. The CITS880s program icons will 
be created in the specified program group.  
Press <Enter> to accept the proposed name, or type in a 
different name in the name box or select an existing group 
(press the drop-down list box arrow to display the current 
group list). 
The installation program will create the CITS880s directory 
and file structure, copy the CITS880s files onto the hard disk 
and create a program group and the CITS880s program item. 
When Setup is complete, click Close to close the Add or 
Remove Programs window. 

mailto:polarcare@polainstruments.com
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Installing the USB driver 

Installing the USB driver on Windows 7 
Log on to the computer as an administrator. 
Once you have downloaded the software from the Polar web 
site, unzip the installer into a suitable folder and run 
Setup.exe from there. Choose the install folder as described 
above; note the location of the install folder – it will be 
necessary to navigate to this folder to install the USB driver. 
When the host PC senses the presence of the CITS880s (see 
Connecting the CITS880s to the USB communication port) it 
will attempt to install the device automatically.  
Alternatively, choose Control Panel|Devices and Printers – 
you should see the Polar USB device listed. 

 
Right click the icon, choose the Hardware tab and click 
Properties:  
From the Properties dialog select the Driver tab, then click 
Update driver… (It may be necessary to click the Change 
Settings button and then choose Update Driver…) 
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Choose Browse my computer for driver software and 
navigate to the CITS880s install folder 
Specify the CITS880s install folder, by default: 
C:\Program Files\Polar\CITS880s on a 32-bit system, 
C:\Program Files (x86)\Polar\CITS880s on a 64-bit system. 
The install folder should contain the driver; click Next. 
Windows confirms the successful installation of the Polar 
WinUSB Device. 

Installing the USB driver on Windows 8/10 
With the software installed connect the CITS880s to the PC 
via the supplied USB 2.0 cable and apply power. When the 
host PC senses the CITS880s (see the User Guide 
Connecting the CITS880s to the USB communication port) it 
will attempt to install the device automatically.  
If unsuccessful, choose Control Panel. (Press the Windows 
key, click the All Apps downward pointing arrow and scroll to 
the Windows System group and choose Control Panel. 
Alternatively, move the mouse to the lower right corner of the 
screen to display the Charms bar (Windows 8) or click the 
Start button (Windows 10) then click the Settings icon. From 
the Settings panel choose Control Panel.) 
In Devices Manager – you should see the Polar USB device 
listed indicating a driver update is required. 

 
Alternatively, in Devices and Printers – you should see the 
Polar USB device listed. Right click the icon, choose the 
Hardware tab and click Properties. From the Properties 
dialog select the Driver tab, then click Update driver… 
Windows displays the driver search dialog. 
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Choose Browse my computer for driver software and 
navigate to the CITS880s install folder. Windows locates the 
driver file and requests confirmation of the driver installation: 

 
Click Install – Windows confirms successful driver installation. 

 
The driver appears in Device Manager 

 
The CITS880s is ready for use 
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Installing the CITS880s licence 
CITS880s operation is enabled via the CITS880s Polarcare 
licensing system. Contact Polarcare at Polar Instruments for 
license installation and support. 

 CITS880s icon 

Hint: The CITS880s program may be started each time 
Windows is started — hold the <Ctrl> key depressed and 
drag the CITS880s icon with the mouse to copy it to the 
Startup group. 
In Windows 10 right click the Start button and choose Run. 
Type shell:startup to open the Startup folder; copy the 
CITS880s icon to the Startup folder 

2-4 Connecting the computer to the CITS 
CITS880s commands and data are transferred between the 
CITS880s and the host computer via a USB 2.0 
communication link. 

Connecting the CITS880s to the USB communication port 
Connect the supplied USB 2.0 cable between the USB port 
of the host computer and the USB connector on the CITS.  

Connecting the CITS880s peripherals 
Plug the Foot Switch D connector into its socket on the rear 
of the CITS. Plug in the 4mm anti-static wrist strap. 
Connect the Barcode Reader (if used) between the keyboard 
and the computer — unplug the keyboard from the computer, 
plug the Barcode Reader into the keyboard socket on the 
computer and plug the keyboard into the Barcode Reader. 

Connecting the cables 
The CITS880s is calibrated before shipment using cables 
labelled with the channel number and CITS880s serial 
number.  
If a cable is replaced the instrument should be re-calibrated 
and the cable relabelled with the channel number and the 
instrument serial number. 
For single-ended testing connect a probe cable to its 
corresponding SMA front panel connector of the CITS880s 
and connect the Polar microstrip IPS probe to the probe 
cable. 
The CITS880s channels are arranged in pairs for differential 
testing; connect the differential probe (e.g. the Polar 
IPDS100 probe) to Channels 1 and 2 or 3 and 4 SMA 
connectors using the supplied cables. 
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Power up the CITS880s and the host computer. The green 
BUSY LED should light for approximately 5 seconds and 
then turn off, indicating that the system is operating normally. 
If applicable, connect a 9-pin D-connector to the Status 
output. Connection details and a description of the function of 
each pin for the Status output are contained in Appendix C. 

2-5 Running the program 

 

To start the program, double click the CITS880s icon with 
the mouse or highlight the icon and press <Enter>. After a 
few seconds the main CITS880s display will appear. Prior to 
testing, allow the instrument to warm up 
Note: If the program is being run for the first time, the System 
Configuration dialog box is displayed. Options can be 
changed at any time during normal operation by choosing 
Config from the Utilities menu.. 

2-6 System configuration 
The system configuration (Config..) dialog allows the 
operator to specify the CITS880s operating environment. 
The environment includes  

system security and editing permissions 
datalogging options 
default paths to test, waveform and snapshot files 
system prompts, colours and languages 
test file import options 
probe test interval options 

From the Options menu select Config... to display the 
Config dialog box. Select the General tab: 
To exit any of the System Configuration menus without 
saving changes press <Esc> or click the Cancel button. 



 

CITS880s User Guide SETTING UP THE CITS880s SYSTEM  •  25 

 
Figure 2-1 The System Configuration menu 

General options 

Demonstration Mode 
Demonstration mode is provided to allow the CITS880s 
program to be operated without an instrument connected. In 
this mode when the Test function is selected the CITS880s 
allows the operator to select a stored waveform for display. 

Editing the default test parameter settings 
Use the Edit Default Test function to define the test 
parameters and settings in the Test Editor when a new test is 
added to the test list. 

System security 
The CITS880s incorporates two levels of security, 
Administrator and Operator. The Passwords options 
enable the Administrator to specify password protection for 
critical system and test file information. The system 
administrator is able to control operator access to each field 
in the Test Setup Editor via the Test Permissions page 

Specifying a password 
Specifying a password is optional; if an Administrator 
password is specified, unauthorised users will be prevented 
from modifying the system configuration, editing test files 
(files containing test parameters) or deleting logged records. 
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If a password is set it will be requested before these 
operations are permitted. 
If an Operator password is set it will be required if an 
operator attempts to alter test parameters. All system 
changes will require the Administrator password. 
To specify a password, activate the Password box and type 
the password — up to 8 characters may be used. For 
security, characters typed will be displayed as asterisks. If no 
password is required leave the field blank. 
Confirmation 
If a password is entered the CITS880s displays a 
confirmation box. Re-type the password in the confirmation 
box to verify the original. 

Activate on Exit 
If a password has been specified, exiting this screen with this 
box checked enables password protection immediately; 
otherwise the password protection is not enabled until the 
software is next run. 

Controlling test file editing permissions 
With an Administrator password specified the CITS880s will 
require the Administrator password to access the Test File 
Editor to alter test parameters for a test or group of tests. 
If an operator password has been specified the Administrator 
is able to grant controlled operator access to the Test File 
Editor. Use the Edit Permissions page to control which test 
parameter fields, if any, may be modified by the operator. 

 

Figure 2-2 Edit Permissions 
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Click each checkbox to enable the associated field as 
required. 
When the operator attempts to modify test parameters the 
system will request a password. Supplying the Administrator 
password will open the Test Setup Editor with full access to 
all test parameters, if the Operator password is entered the 
Test Setup Editor opens with only the parameters checked in 
the Edit Permissions page enabled. Press OK to confirm and 
close the dialog. 

Logging off the current user 
To switch between Administrator and Operator (without exiting 
the program) choose the Utilities|Logoff current user 
command. At the next attempt to modify test parameters the 
system will request a password. Enter the Administrator or 
Operator password as required. 

Setting default file locations 

Setting the Path to Testfiles options 
Click the Paths tab and use Path to Testfiles to specify the 
location for test parameter files. 

 

 
Select Testfile Target 
Folder…button 

Test files are stored by default in the 
C:\Users\username\AppData\Roaming\Polar\CITS880s\TestFiles\ 
folder; to choose another folder click the Custom option button 
and use the Select Testfile Target folder…button to navigate to 
the target folder. 

Setting the path to waveform / snapshots files options 
During data logging, users can allow waveform and snapshot 
files to be saved automatically at the datalog point.  

 

During data logging waveform and snapshot files are saved 
and named using the board serial number and test name. 
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Waveform and snapshots files are stored by default in the 
same folder that contains the test file; choose another folder 
via the Custom option. 

Setting the path to the cable and probe test log file 
By default, the results of cable and probe tests are stored in 
the same folder as test files. 

 
To choose another folder click the Custom option button and 
use the Select Target folder…button to navigate to the new 
target folder. 

Setting the Datalog options 
The Datalog dialog allows the operator to specify data 
logging options. 

 
Figure 2-3 The Datalog dialog tab 
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Specifying a Station ID 
Click into the Station ID field and type the name of the test 
station. This is used when multiple CITS880s stations are data 
logging to a common log file 

Specifying the date format 
The CITS880s data logging can record the date in one of 
three common formats. Choose from DD/MM/YY or 
MM/DD/YY or YY/MM/DD formats. 
Defining custom information fields 
Specify user fields to provide additional board information 
(e.g., batch ID, material, process, etc.). User fields can be 
completed during the datalog process. 

Check for Duplicate Serial Numbers 
Specify optional checking of serial numbers for duplicates 
during data logging 
Change the destination folder for logged data. 
Activate each field via its check box then type the name of 
the field into the associated text box. 

Checking for duplicate serial numbers 
If this option is set, the CITS880s will check for unique serial 
number entry during data logging. 

Specifying the Datalog folder 
Datalog files are located by default in the 
C:\Users\username\AppData\Roaming\Polar\CITS880s\TestFi
les folder (assuming a default installation). To specify a 
different folder, click the Custom option button. 
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Figure 2-4 Select Datalog Target folder dialog box 

Navigate to the data logging folder and press Open. 
Note: if necessary, create the folder by right clicking a blank 
area within the Select Datalog Target Folder… dialog box 
and choosing New then Folder from the shortcut menus. 
See the Windows User Guide for details. 

Changing the system prompts 
The CITS880s incorporates facilities automatically to display 
confirmation or information dialog boxes as test files are 
created, loaded or deleted. Click on the Prompts tab to 
specify the system prompt options: 

• Display a Confirm Delete message to prevent 
accidental deletion of a test file 

• Automatically display the Board Details dialog box 
each time a new test file is generated 

• Show the Board Notes (a text box containing notes, 
instructions, etc. for a board under test) as a test file 
is loaded 

• Display a Confirm message to clear the board 
waveforms currently in the Test Window 

• During data logging tests may be cycled through in 
sequence automatically (if Auto Advance from the 
Datalog menu is selected).  
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• The operator can specify a brief view of each 
waveform as the CITS880s advances through the 
tests. Click Delay before Auto Advance and specify 
a time in seconds; the system will pause for the 
specified time before advancing to the next step. 

• CITS880s displays a warning that the relays are 
approaching end of usable life – this setting allows 
the user to specify when the warning is triggered. 

• CITS880s displays a warning at switch on when a 
recalibration is due in order to maintain its full 
specified performance – choose the number of days 
before the calibration due date that the warning will 
be displayed. 

• Sound an audible warning when a board passes or 
fails the test process. Customize the audible 
warning If Beep on Pass or Beep on Fail are 
checked by navigating to a suitable audio file (in 
.wav format.) 

 

Figure 2-5 Prompts dialog 

Click the associated check box to select each option. 
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File Import horizontal fine adjustment 
The CITS880s can import files from earlier versions of the 
CITS; if necessary use the File import Horizontal Fine 
Adjustment setting to provide horizontal offset in inches or 
millimetres. 

 
Figure 2-6 File Import horizontal fine adjustment 

Choose the Distance units and specify the horizontal offset in 
the selected units. 
Set the Time adjustment in nanoseconds. 

Probe Test 
Use the Probe Test options to specify the frequency of 
prompts for Probe Verification testing. 

 
Specify the frequency from the Prompt Frequency dropdown 

 

Probe verification can be manually requested, when a new 
file is created and the first test run or at a user-specified 
interval. 
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Changing the CITS880s display colors 
Click the Colors tab to change the colors of objects 
(waveforms, cursors, graticules, axes, etc.) in the display 
window. 

 
Figure 2-7 Display Colors dialog 

Click on the object name/color then click the Edit button to 
display the color palette. If necessary click Define Custom 
Colors to choose from a wider range of available colors (the 
actual range will depend on the graphics card installed on 
the machine). 
Color choices are grouped into Schemes. Click Add New 
Scheme and supply a descriptive name to create a new 
scheme. 
Click Default Selected to set the current scheme object 
color to its default value. 
Click Default All to reset all object colors in the scheme to 
the default values. 

Importing/exporting schemes 
Schemes may be transferred between CITS880s 
installations. Click Export Scheme to save the scheme 
under a descriptive name. Click Import Scheme to load a 
previously exported scheme. 
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SECTION 3 — GETTING STARTED 

FIRST TIME CITS880s OPERATION 

IMPORTANT Observe antistatic discharge precautions at all times 
The CITS880s is a sensitive measuring instrument. To prevent damage to the CITS, 
always observe antistatic precautions. Polar IPS and IPDS probes are precision moulded 
from ESD dissipative materials and include internal ESD grounding. For maximum 
protection against ESD damage Polar recommends operators use a wrist strap connected 
to an appropriate ESD ground point. See Appendix B for more information 

This section discusses the basic operation of the CITS880s 
program using the sample test coupons included with the 
CITS.  
First time operators are encouraged to work through this 
section using the coupons and test files provided to verify the 
correct operation of the CITS880s and quickly gain familiarity 
with the impedance testing procedure. 

 CITS880s icon 

Power up the CITS880s, double-click the CITS880s icon on 
the desktop to start the CITS880s program. The CITS880s 
main screen is shown in Figure 3-1. Allow the instrument to 
warm up to achieve calibrated status for critical 
measurements. 

 
Figure 3-1 The CITS880s main screen 

Note: the colours of the screen displays may be changed at 
the option of the user — the screen views used in this 
manual may differ from the system in use. 
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The CITS880s screen 
The CITS880s screen window is split into three window 
panes and comprises six sections: 
The Test List window pane which lists the tests within the 
active test file. 
The Waveform Display window pane which displays the 
impedance waveform and test results. 
The Datalog Results window pane which displays logged test 
results (e.g. for a batch of boards using the active test file). 
The menu bar containing all the CITS880s commands. 
The tool bar, which provides short cut access to the most 
commonly used commands. 
The status bar, which displays descriptions of the tool bar 
buttons as the mouse is moved over each button and test and 
data logging information. 
The CITS880s window may be increased or decreased in 
size by dragging the window borders with the mouse. 
If necessary, press the Maximise button to increase the 
display size to full screen. 

The CITS880s main tool bar 
The CITS880s main toolbar (described in detail in the next 
section) contains buttons that provide quick mouse access to 
the most frequently used CITS880s commands: 

 
(This section discusses only the File Open and Execute 
Test buttons.) 

 

The File Open button displays the Open dialog box and 
allows the user to choose a test file. Each test file contains 
one or more tests for the board under test. 
 

 

The Execute Test button performs a test using the 
selected test list item. 

3-1 Testing the sample coupon traces 
When testing, wear a wrist strap connected to a suitable 
earth point. A wrist strap is provided with the CITS; connect 
the wrist strap to the wrist strap stud on the CITS880s front 
panel. 
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The CITS880s includes a sample coupon to allow users to 
familiarise themselves with the operation of the instrument. 
The coupon includes three single-ended PCB traces of 
nominal impedance, 50Ω, 75Ω and 100Ω and one differential 
trace of nominal impedance 100Ω. The CITS880s software 
includes a test file incorporating the 50Ω, 75Ω and 100Ω 
tests associated with the coupon. 
Note: the sample coupon includes impedances of nominal 
value only and should not be used for calibration purposes. 
To test any PCB trace it is necessary to select the correct 
test file for the board trace under test. This file includes the 
nominal trace impedance to be tested for, the test channel, 
the test tolerance and the distance over which to test. In this 
section test the sample coupon supplied with the CITS880s. 
Note: the CITS880s should be allowed to warm up prior to 
use in measurement – calibration will be invalid until the 
warm up period has completed (approximately 20 minutes.) 

Selecting a test file 

 File Open... 

From the File menu select Open... or press the Open... 
button on the tool bar with the mouse — the Open dialog 
box appears with the test files listed. See Figure 3-2. 

 
Figure 3-2 The Open Test File dialog 

Note: file locations may vary dependent on installation. 
The Demonstration file contains the tests associated with the 
sample coupon. This example will test the coupon’s 50Ω 
trace using the 50 Ohm Single test in the Demonstration file. 
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Select the Demonstration file and click OK. The CITS880s 
loads the selected test file and displays the list of trace tests 
for the coupon in the Test List window pane. See Figure 3-3 
below. 
The CITS880s provides the option of selecting test files from 
the list using the mouse or keyboard arrow keys or using the 
CITS880s foot pedal to advance through the list and perform 
each test in the sequence without the use of mouse or 
keyboard. If a barcode reader is used this is entered at the 
start of a cycle. 
Click on the 50 Ohm Single test — the Waveform Display 
pane reflects the impedance and distance scales for the test 
and cross hatched areas indicating the distance or time 
region over which impedance will be tested.  
The impedance scale indicates the nominal impedance and 
the PASS and FAIL impedance ranges. An INTERMEDIATE 
(i.e. guard-band) range (shown below) may optionally be 
added between the PASS and FAIL ranges. 

 
Figure 3-3 The CITS880s Test Window with the Demonstration file loaded (50 Ohm Single test selected) 

Note: these are sample settings that may be changed by the 
user so may differ between systems. 
Click on the 75 Ohm and 100 Ohm tests and note the 
changes in the Waveform display window. 
For the test shown in Figure 3-3 the nominal impedance has 
been specified in the test file as 50Ω ±5% so the acceptable 
range of impedance values for a PASS result is from 47.5 – 
52.5Ω. The FAIL threshold is set at ±20% so the range of 
impedance values for a FAIL result is less than 40 ohms or 
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greater than 60 ohms. Between the PASS and FAIL values 
the CITS800s returns an INTERMEDIATE result. The test is 
performed on a 50Ω coupon trace (from 2.75” to 6.75”). 

Performing the single-ended tests 
When executing the test ensure the Microstrip probe signal 
pin is connected to the signal pad and the probe ground pin 
to coupon ground pad. Typically, ground connections have 
square pads to distinguish them from signal pads. Probe pin 
spacing (pitch) should match the spacing between signal and 
ground pad holes. The probe tips should be of appropriate 
diameter and profile with suitably sharp edges so as to 
provide accurate and repeatable contact with the pads. 

 

Minimising aberrations 
It is important to use high quality test connections (e.g. use 
Polar supplied microstrip probes) to minimise aberrations. 
Polar IPS and IPDS probes are precision moulded from ESD 
dissipative materials and include internal ESD grounding. 
Probe connections should be tightened with the Polar 
supplied torque wrench to ensure a good connection. 
For maximum protection against ESD damage Polar also 
recommends operators use a wrist strap connected to an 
appropriate ESD ground point. 
Choose the Datalog menu and ensure the Autolog 
command is off (un-ticked). 

 CITS880s Test 

To test the coupon, connect the microstrip probe across the 
50Ω test impedance and press the foot switch or click the 
Test button. Take care not to touch the track on the coupon 
during testing. 
The system will set up the instrument for testing and then 
graph the impedance of the 50Ω trace. 
The CITS880s displays the trace's impedance against the 
test program limits. See Figure 3-4. 

Signal padGround pad
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Figure 3-4 Graph of 50Ω impedance within limits 

If the waveform remains between the PASS limits over the 
whole of the tested region the CITS880s records a PASS. 
If necessary, use the up and down arrows to move the 
display vertically to view portions of the trace. 

Displaying the impedance statistics 
The CITS880s displays the PASS, INTERMEDIATE or FAIL 
result for the test and displays the impedance statistics over 
the tested area: 

average impedance 
standard deviation 
maximum impedance 
minimum impedance 
maximum – minimum impedance (optionally) 

The tested area is usually the flattest portion of the coupon 
waveform and is usually referred to as the undisturbed 
interval (ignore test connection aberrations and open circuit 
termination effects). 
Values are presented in the associated boxes on screen 
along with the impedance waveform. If the displayed 
waveform extends into the INTERMEDIATE region the 
CITS880s records an INTERMEDIATE result; if any part of 
the waveform traverses into the crosshatched area the 
CITS880s records a FAIL. (See also the Test Editor for the 
Average and Envelope test methods.) 
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(If the CITS880s records an INTERMEDIATE or FAIL on the 
sample coupon, check for correct probe/coupon polarity and 
good contact between the microstrip probe and the trace on 
the coupon and try again.) Repeat the procedure for the 75Ω 
and 100Ω nominal impedance traces on the sample coupon 
using the 75 Ohm Test and 100 Ohm Test respectively.  
See below for the 100 Ohm Differential test using the 
IPDS100 Differential probe. 
As each test is completed a result symbol is displayed 
alongside the test in the Test List window pane to indicate a 
PASS, INTERMEDIATE or FAIL result (see table below) for 
the trace along with the Average value of impedance for 
each test (see Section 4.6 — Adding columns to the Test List 
to display other values.) 

PASS  Green tick 
INTERMEDIATE  Yellow clockwise open arrow 
FAIL  Red cross 

Test results for all tests performed on the coupon are also 
recorded in the Datalog window pane. Yellow circles 
alongside test results indicate that the logged results have 
not been saved to disk. 
The Status Bar indicates which test is currently displayed. 
When all tests are complete, step through and review each 
test result (waveform and statistical results) by clicking the 
test name in the Test List window pane. 

 
Fig 3-5 Completed set of Coupon Test results 
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Using the measurement cursors 
The CITS880s incorporates on-screen measurement cursors 
to display absolute values of propagation delay time, distance 
and impedance along the displayed waveform. Use cursors 
for critical time measurements — click onto each cursor and 
drag it with the mouse to the point of interest on the 
waveform. Each cursor displays the distance along the trace 
and impedance where the cursor crosses the waveform. The 
distance between the cursors (propagation delay time, delta 
time and distance between the cursors) are displayed above 
the Waveform Display window pane. Delta time (or real time) 
is the “out and back” time of the TDR signal. Propagation 
time, the “out only” time is calculated as half that value. 

Testing the Differential coupon 
The sample coupon includes a 100Ω differential pair. 
Connect the IPDS100 Differential Probe to the Channels 1 
and 2 SMA connectors on the CITS880s front panel. 
Select the Differential 100Ω Ohm Diff Test. Locate the 
IPDS100 Probe across the 100Ω impedance and press the 
Test button. 

 
Figure 3-6 Differential Coupon Test PASS result 

The differential pair returns results as for the single-ended 
case but can also include values for crosstalk, odd and even 
mode impedance and unbalance between the lines. 
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Odd mode impedance is defined as the impedance of either 
of the conductors in a differential pair when both drives are 
driven differentially (i.e. with signals of equal and opposite 
polarity) so odd mode impedance is equal to half the value 
for differential impedance in a balanced system. 
Even mode impedance is the impedance of either of the 
conductors in a differential pair when both drives are driven 
in common mode (i.e. with identical signals of the same 
polarity.) 

Adding a test with the Setup wizard 

Setup Wizard 

First time users may find it helpful to use the Board|Setup 
Wizard… which provides a guide through the steps required 
to create a test for a board trace. 
Connect the cables and appropriate probe. 
The Wizard includes steps to specify the test parameters 
(test type, test channel(s) and impedance value) and locate 
the open circuit at the end of the probe. With the probe at the 
trace launch point; the Wizard selects a suitable horizontal 
range to display the trace waveform and the test region for 
the trace, choosing the Test From and Test To distances. 
From the Board menu, choose Setup Wizard… 
Locating the open circuit at the end of the probe 

 
Figure 3-7 Locate open circuit at end of probe 

Choose the test type (Single ended, Differential or 
Groundless Differential) and channel or channel pair and add 
the description and impedance value. The Wizard locates the 
open circuit at the end of the probe. Click Next. 
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Calculating the horizontal range and test region 

 
Figure 3-8 Locate open circuit at end of test trace 

Locate the probe at the trace launch point and click Next. 
The Wizard will propose the most appropriate test region (the 
Test From and Test To horizontal values) 

 
Figure 3-8 Wizard proposed test region 

If necessary, move the cursors to a more suitable part of the waveform – usually the 
flattest portion of the waveform – see the example graphic below. 
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Figure 3-9 Move cursors to define test region 

Click Finish – the Wizard reflects the chosen test region. 

 
Figure 3-10 Cursor defined test region 

Use the Test Editor to specify other test parameters. 
Saving snapshots 
When all tests have been completed the test file with all its 
tests and associated waveforms and results can be saved for 
later recall as a snapshot (see next section System 
Operation – The File Menu.) 

3-2 Exiting the program 
Select Exit from the File menu or press Alt+F4 to leave the 
program and return to the Windows Program Manager. 
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SECTION 4 — SYSTEM OPERATION 

USING THE CITS 

IMPORTANT The CITS880s is an extremely sensitive measuring instrument. 
To prevent damage to the CITS880s observe static precautions at all times. 
Polar IPS and IPDS probes are precision moulded from ESD dissipative 
materials and include internal ESD grounding. For maximum protection against 
ESD damage Polar recommends operators use a wrist strap connected to an 
appropriate ESD ground point. See Appendix B for information. 

STARTING THE CITS 
Note: The CITS880s should be allowed to warm up prior to 
use in measurement – calibration will be invalid until the 
warm up period has completed (approximately 20 minutes.) 
Double clicking the CITS880s icon starts the program. When 
the CITS880s program runs, the main CITS880s screen is 
displayed loaded with the last test file used – Figure 4-1. 

 
Figure 4-1 The CITS880s main screen 
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4-1 The CITS880s screen 
The CITS880s window is split into three main areas: 
The Test List window pane contains each named test within 
the currently selected test file. 

 
The Waveform Display window displays the impedance 
waveform and statistical results for the selected test. 

 
Figure 4.2 CITS880s Waveform Display Window 

The Datalog Results window pane displays the logged results 
for one or more boards using the current test file. 

 
The CITS880s includes two control sections: 
The menu bar containing all the CITS880s commands 
The tool bar which provides short cut access to the most 
commonly used commands. 
The status bar displays descriptions of the tool bar buttons 
as the mouse is moved over each button and test and data 
logging information. 
The CITS880s window may be increased or decreased in 
size by dragging the window borders with the mouse. 
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The main screen window can be maximised to full screen 
view if desired — click the Maximise button (or double-click 
the CITS880s Title Bar or press Alt+Spacebar then X on the 
keyboard.) 

4-2 The CITS880s menu bar 
All CITS880s commands are available from pull-down 
menus; commands can be accessed via the keyboard or 
mouse (see OPERATING THE CITS880s.) 

The File menu 
Use the File menu to process CITS880s test files. 

 

Employ these menu commands to: 
Create new test files 
Open existing files (including files in XML format) 
Scan  
Save existing files 
Convert legacy format files 
Save and open snapshots 
A snapshot is a test file with one or more completed tests 
along with their associated waveforms and test results. 
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If it is necessary to open files in a legacy format (for example 
files using earlier style probes) or move differential tests to 
different channels choose the Batch Convert Legacy Files 
command and select the appropriate options. Press OK and 
follow the steps to choose and save files. 

 
Choose a CITS880s test file via a barcode reader 
The CITS880s Scan Barcode dialog can be utilised to scan 
the barcode for the item to be tested (for example, a controlled 
impedance test coupon) and load the associated CITS test file 
from the CITS880s test files folder. Both CITS native .CIF and 
XML test files can be loaded via the barcode reader. 
Choose and set up printers for hard copy 
Preview and print the displayed waveform, datalog results or 
test file list 
Exit from the CITS880s program 
When the File menu appears the last five test files opened 
are listed in reverse order. 
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The Board menu 
The Board menu contains the commands to insert new tests 
and modify existing board test parameters within the current 
test file. 

 

Board information 
Typically, each board will have an associated test file 
containing all the tests for the controlled impedance traces 
on the board. Each board test file will include board setup 
information Details… (e.g. customer name, board type and 
part number) along with notes for the board (comments, 
special instructions, etc.) Board notes will be displayed as 
the test file is loaded. 
Use the Clear All Waveform commands to remove all test 
result waveforms from the test window; the Save all 
Waveforms As Reference allows the on screen waveforms 
to be stored as reference for future tests. 

Creating and editing board tests 
Use the Insert TDR test… command to add a controlled 
impedance trace test to a board test file: the Test Editor is 
displayed to allow test parameters to be specified for the new 
test (see Test Editor for a discussion of test parameters.) 
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Figure 4.3 CITS880s Test Editor 

Supply a descriptive name for the test and layer name and 
trace impedance. 
Choose the test type, single ended, differential or groundless 
differential and select the CITS880s channel or channel pair. 
Specify the horizontal units (distance or time) and the probe 
length and test region (normally to test the flattest portion of 
the trace waveform.) 
Choose the Test Method (the default method is the Absolute 
Method.) 
Specify the tolerance (the tolerance about the nominal 
impedance to which the track will be tested.) See the screen 
graphic below. 

 
Figure 4.4 CITS880s Waveform Display Window – Pass Result 
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The Waveform Display pane reflects the impedance and 
distance scales for the test. The graphic above shows upper 
and lower red cross hatched (FAIL) areas, upper and lower 
green (INTERMEDIATE) areas and the clear (PASS) area 
between them, indicating the region over which impedance 
will be tested.  
The impedance scale indicates the nominal impedance and 
PASS, INTERMEDIATE and FAIL impedance ranges. 

PASS, INTERMEDIATE and FAIL test limits 
The CITS880s test file accepts PASS and FAIL impedance 
limits or, using the Intermediate option shown in the dialog 
below, PASS, INTERMEDIATE and FAIL impedance limits. 
The INTERMEDIATE test results provide a guard band 
between PASS and FAIL. 
In the example above, the test indicates a PASS if the 
impedance value remains within the clear area, i.e. falls 
within ±10% of the nominal impedance over the test area. 
A reading of between 10% and 15%, defined as the 
INTERMEDIATE limits, indicates the test should be run 
again or the result referred for consultation. 
A reading of greater than ±15% from the nominal impedance 
is recorded as a FAIL. 
An INTERMEDIATE result is shown below. 

 

Figure 4.5 CITS880s Waveform Display Window – Intermediate Result 
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Setting tolerance values 
Tolerance values are set within the Tolerance section of the 
Test Editor dialog box.  

 

Using locked tolerance values 
If the Intermediate option is not required, the Plus and Minus 
tolerances may be locked; i.e. the Plus and Minus settings 
have the same value, or unlocked, where the Plus and Minus 
tolerance value is set independently.  
Uncheck the Intermediate box, click the Locked check box to 
lock or unlock the tolerance and enter the limit values. 
Values may be specified as a percentage or in Ohms. 
If the Intermediate check box is ticked tolerances are locked 
and the Locked option is disabled. 
The tolerance must be set to a value in the range 0.10% to 
99.99% in 0.01% steps; alternatively, it may be set directly in 
Ohms. Click the % or Ohms option buttons to select. 

Editing a test 
The Edit… command allows changes to be made to existing 
tests.  
The Delete command removes the test from the test list; 
choose Test to run the test on the trace. 

Using the time/distance cursors 
Propagation delay times may be measured by positioning the 
cursors at the beginning and end of the test specimen. 
The screen displays the distance and impedance where 
each cursor crosses the impedance waveform. 
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The Snap Test Limits to Cursor command allows the user 
to change the distance over which the trace is tested to the 
distance indicated by the cursor positions. 

 
Figure 4.6 Snap Test Limits to Cursor 

Use the Snap Test Limits to Percent between Cursors 
command to change the horizontal Test From and Test To 
limits to percentage values of the current lower and upper 
cursor time positions.  
The Autoset Test Limits sets the horizontal Test From and 
Test To limits to encompass the flattest portion of the 
waveform. 
The Calc Slope of Test Region command returns the first 
cursor position and slope of the measured signal within the 
horizontal Test From and Test To limits.  

 
Figure 4.7 Calc slope of test region 

The values may be applied to the current waveform and to 
the DC Resistance Compensation settings of the test for 
future measurements. 
Note that if the calculated value is negative the slope of the 
waveform cannot be due to trace resistance. 
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The Board menu includes the Setup Wizard… command 
that will guide the user through the steps required to create a 
test for a board trace. 

Editing groups 
Individual trace tests may be designated as members of a 
named group and tested for impedance spread across the 
group. 

The Datalog menu 
The Datalog menu allows the user to control the CITS880s 
data logging facilities. Data logging enables test data to be 
automatically recorded to a text file for archiving and 
subsequent analysis. The log file can be printed out or 
imported into a spreadsheet for analysis or the optional 
Datalog Report Generator. 

 

Ordering the datalog 

The data log can be sorted by record creation order or by 
board serial number. 

Automatic data logging 
Automatic data logging can be toggled on or off via the 
Autolog command. Autolog is ON by default and its status 
is saved between sessions. 
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Auto advancing through tests 
Tests may be cycled through in sequence automatically or 
manually selected. If Auto Advance is selected the 
CITS880s steps through the test list from the top depending 
on the Auto Advance option specified (Off, On Pass, After 
Test). 
If the Delay Before Auto Advance option has been selected 
(see the Config|Prompts dialog in the Utilities menu) the test 
waveform is displayed briefly before Auto Advance moves 
to the next test. 

Saving waveforms and snapshots on datalog 
If the Save all Waveforms as CVF (.cvf) files) and 
Save Snapshot check boxes (see the Datalog - Board 
Information dialog) have been checked, waveform files and 
snapshots will be saved automatically at the datalog point. 
During the data logging process waveform files will be saved 
and named using the board serial number and test name (for 
example, SN123_Test50Ohm.cvf). 

Starting the Datalog Report Generator 
The Datalog Report Generator command starts the optional 
Datalog Report Generator. 

Reloading the datalog file 
The Reload Datalog File command allows CITS880s users 
logging data to a common datalog file on a network server to 
refresh the local copy of the datalog file with the updated 
data from the server. 

Exporting the datalog file 
The Export as CSV command saves the datalog in comma 
delimited format; the contents and order of the exported file 
are the selected columns shown in the datalog window. 
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The Waveform menu 

 

The Waveform menu allows the operator to: 
Save the current waveform as the reference waveform for a 
test file via the Save Reference command — this reference 
waveform is then displayed in green (default color) whenever 
the test file is selected. Reference waveforms are retained 
even when the screen is cleared. View Reference toggles the 
reference display on and off. The reference waveform is 
removed via the Delete Reference command. 
Reference waveforms will be removed from the test file when 
the associated test parameters are changed. 
Overlay multiple waveforms — allowing comparison of a 
sequence of test results. 
Record (save) the current waveform to disk for later viewing. 
View recorded waveforms. 
In differential tests, view the single ended and even-mode 
impedance waveforms for engineering analysis. 
In differential tests, assign the measurement cursors to the 
differential, single ended or even mode waveforms. 

The View menu 
The View menu allows the user to control the display of 
CITS880s screen items (readout, cursors, graticule, toolbar, 
etc.). Results can be optionally displayed in mRho 
This menu also allows the user to select for display statistical 
information in the Test List and Datalog window panes. 

The Utilities menu 
The Utilities menu allows users to: 

Change operating conditions during normal CITS880s 
operation  
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Import test files from earlier CITS880s versions 
Calibrate the CITS880s (using the appropriate license) 
Learn the cable lengths of one or more of the four 
channel test cables 
Add relay and cable tests to a test file. 
Verify the test probes 

 

Config… 
Use the Config command to change System Configuration 
options (see SYSTEM CONFIGURATION for more details). 

Import… 
Use the Import command to open CITS880s test files 
produced using earlier versions of the product. Use the 
dialog to open files with .mrf or .tst extensions. 

Calibrate CITS 
Contact your local Polar office for calibration and licensing. 

Learn Cable Length 
Use the Learn Cable Length command to measure the 
lengths of the cables (without the probes) attached to the  
four channels. 

 



 

58  •  USING THE CITS CITS880s User Guide 

Ensure all probes have been removed from all the selected 
cables and click the check box for each channel to be tested 
or All for all four channels. 
Click Learn – the CITS880s will learn and display the new 
results in the Learn Cable Length dialog. 

 

Relay and Cable Test… 
The Relay and Cable Test… provides predefined test 
programs for each channel to verify the operation and 
integrity of the cables and relays. 
A relay and cable test for each channel will be added to the 
end of the current test file; it is suggested that a new test file 
be created to run these tests. Delete these tests from the test 
file after use – they are specific to the hardware state ONLY 
at the time of testing. 
With the tests added to the test file, ensure all probes are 
removed from their cables and the End of Probe calibration 
has been completed then select and run the test for each 
channel in turn; the impedance value and waveform is 
displayed for each channel. See the graphic below. 

 

Figure 4-8 Relay and Cable Test 
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Verifying the test probes 
Use the Probe test accessory ACC450 to verify the basic 
operation of the test probes. 

 

Connect the probe(s) to their respective CITS880s channels. 
Locate the probe pins on the Ground and Signal pads on 
ACC450, highlight each channel / probe structure and click 
Test. The probe test may optionally be added to the test list. 

 

The Help menu 
The Help menu Help Topics provides online access to the 
CITS880s User Guide — press the F1 function key to access 
the on-line help from anywhere in the program. 
If a an Internet connection is available, select Visit Polar 
website to access the Polar Instruments web site for product 
and application information or Check for Updates to request 
updates to the software. 
Select About CITS… for system information (calibration due 
date, remaining relay life and software and firmware versions,) 
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4-3 The CITS880s main tool bar 
The CITS880s main toolbar contains buttons that provide 
quick access to the most frequently used commands: 

 

 
Press the File New button to create a new test file. 

 

File Open... — press this button to display the Select 
Test File dialog box and choose a test file. Each test file 
contains one or more tests for the board under test. 

 

Scan Barcode — Open the Scan Barcode dialog to 
scan the barcode for the item to be tested (for example a 
test coupon) and load the associated CITS test file 

 
File Save — save the current test file. 

 
Board Edit — start the Test File Editor 

 
Setup Wizard — add a guided test with the Setup Wizard 

 

Execute Test — perform a test using the selected test 
file. 

 

Print waveform — send current waveform to printer for 
hard copy. 

 

Datalog Report Generator — start the (optional) 
Datalog Report Generator. 

 
Clear Screen — clears the waveform display window. 

 

Export to Microsoft Excel — save the contents and 
order of the datalog in CSV format 

 
Verify Probe — verification testing of IPS probes 

 

Visit Polar Website — Access the Polar Instruments 
Internet Web site for updates and application information. 
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4-4 The Waveform Display window pane 
When a test is executed the CITS880s displays the resulting 
impedance waveform along with the test limits (the PASS, 
INTERMEDIATE (guard-band) and FAIL hatched areas), and 
the results of the test in the Waveform Display window pane. 

 

Fig 4-9 Waveform Display window pane 

The PASS/INTERMEDIATE/FAIL result is displayed along 
with the statistical data for the tested region of the displayed 
waveform included in the statistics/results area — the upper 
left corner of the Waveform Display window pane. The tested 
region is commonly referred to as the undisturbed interval (or 
flattest portion) of the waveform and delimited by the width of 
the test limits (the intermediate and crosshatched areas — 
shown in orange and red by default). 
On completion of a test the resulting test waveform is 
displayed, a PASS, INTERMEDIATE or FAIL result is 
reported and displayed statistical data are updated. 
For single ended measurements four values are displayed: 

Average impedance 
Standard deviation 
Minimum impedance 
Maximum impedance 

Other values such as the range between maximum and 
minimum impedance may also be added for display. 
Note: If the test limits are correctly set the average 
impedance is the measured characteristic impedance for the 
trace under test. 
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When differential impedance measurements are specified in 
the test (i.e. when testing a differential pair of traces) 
additional values are displayed: 

Odd mode impedance 
Even mode impedance 
Crosstalk (optional license) 
Unbalance (shown as a percentage) between the lines 

 
Fig 4-1 Waveform Display window pane – differential measurements 

During differential testing the CITS880s records the 
differential impedance of the pair of traces, the single-ended 
impedance of each line to ground and the differential even 
mode impedance of the pair. To view the single-ended and 
even mode waveforms right-click the waveform window and 
select Show Differential Waveforms. 

 

Fig 4-11 Showing Differential Waveforms 
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The Waveform Display shortcut menu 
Right-clicking into the Waveform Display window pane 
displays the Waveform Display shortcut menu: 

 

The shortcut menu contains the most commonly used 
functions previously described for waveform display. 
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Vertical and horizontal axes 
The vertical axis is graduated in Ohms/div by default. The 
vertical deflection factors (Ohms/div) for each test are 
derived from the settings in the test file (see Section 5 — 
EDITING TEST FILES). 
The deflection factor can be changed on screen by right-
clicking the mouse on the vertical scale and selecting a new 
deflection factor from the short cut menu: 

 

The vertical axis can also be graduated in mRho. Select 
Display in mRho from the shortcut or the View menu. The 
CITS880s converts the current Ohms/div setting to mRho. 
The horizontal axis is graduated in units of distance or time. 
When measuring distance (i.e. along the controlled 
impedance trace) the units of measurement can be selected 
by right clicking the horizontal scale: 

 

Horizontal units are graduated in inches, feet, millimetres, 
metres, nanoseconds or picoseconds. 
Changing the vertical and horizontal deflection factors via the 
shortcut menus method will not invalidate the results of a test. 
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Group testing 
Individual trace tests may be designated as members of a 
named group and tested for impedance spread across the 
group. 
From the Board menu choose the Edit Groups… command 
— the Group Test Management dialog is displayed. 

 

Enter a group name and maximum impedance spread for 
each group; up to five groups may be specified. Use the Test 
List Editor to designate a test as a member of a group; see 
EDITING TEST FILES. 
When grouped tests are run the display reflects the result of 
the test along with its results within the group. The test list 
displays a combination of ticks, retest arrows and crosses 
and the spread results are included in the statistical display 
(Zs) on screen. 

 
Fig 4-12 Waveform Display window pane – Group Test Results 
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4-5 The Test List 
The Test List is displayed in the Test List window pane. 
The List contains one or more columns, or fields, displaying 
information (for example, the description, test parameters or 
test results, if any) for each test in the active test file. 
Descriptive and parameter information is derived from the 
entries and settings in the Test Setup Editor window. By 
default the Description (i.e. the test name) and the Average 
impedance result are displayed. 
Test results include a PASS / INTERMEDIATE / FAIL result 
along with statistical information for the test. The Description 
field displays the PASS result (green tick), INTERMEDIATE 
(orange retest arrow) or FAIL (red cross) for both absolute 
and group spread values. 

Adding columns to the Test List 
To add fields to the Test List right click into the Test List 
window pane — the Test List short cut menu is displayed: 

 

Choose the Select Columns… command to display the 
Select Test List Display Columns dialog box. 

The Select Test List Display Columns dialog box comprises 
two list boxes — the box on the left lists the fields which are 
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still available for inclusion in the Test List pane, the box on 
the right lists the currently displayed fields. 

 
Fig 4-13 Adding and removing fields with the Select Testlist Display Columns dialog box 

To add a column, select the field from the list of available 
fields and click the Add button; to remove a column, select 
the field from the list of displayed fields and click the Remove 
button. 
To select a group of adjacent fields drag the mouse over the 
range of fields; to select non-adjacent fields, hold the Ctrl key 
down while clicking on the fields of interest — press OK to 
confirm the selection. 
Pressing the Reset button restores the displayed fields to the 
default Description and Average fields. 

4-6 The Datalog 
Test results are recorded in the Datalog window pane. 

 

With a test file loaded, as the first test is executed the test list 
is added to the Datalog window. As each test is executed its 
results are displayed in columns in the Datalog. 
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To display other result fields right click into the Datalog 
window pane and choose Select Columns — the Select 
Datalog Display Columns window is displayed: 

 
Fig 4-14 Adding and removing fields with the Select Datalog Display Columns dialog box 

Click on the field of interest in the list of available fields and 
press Add to include a new column to the Datalog window 
pane. To remove a column, select the field from the list of 
displayed fields and click the Remove button. 
If logging is turned off, each time a test is repeated the test 
results overwrite previous data. A yellow circle alongside 
each test result signifies that the results have not been 
logged. Data logging is discussed in Section 4-9 – LOGGING 
TEST DATA  

4-7 The Status bar 
The CITS880s status bar displays activity and status 
information and messages to assist the user during 
CITS880s operation. 

 
Figure 4-15 CITS880s status bar 

The status bar comprises three sections: 
Current activity — the CITS880s reports its current 
activity, Ready... etc. When the mouse is moved over a 
Toolbar button this portion of the Status Bar is used to 
display a brief description of the button function. 
Test step number 
Data logging information — the number of logged items, 
updated as each batch of tests is completed for a board. 
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Calibration state — the CITS880s applies a time delay of 
approximately 20 minutes to allow for warm up and 
stabilisation. During this interval the status bar displays the 
count down until calibration is valid along with a message 
that calibration is not yet valid: 

 

CITS880s serial number 

4-8 Testing printed circuit boards 
 

IMPORTANT The CITS880s is an extremely sensitive measuring instrument. 
To prevent damage to the CITS880s observe static precautions at all times. 
Polar IPS and IPDS probes are precision moulded from ESD dissipative 
materials and include internal ESD grounding. For maximum protection against 
ESD damage Polar recommends operators use a wrist strap connected to an 
appropriate ESD ground point. See Appendix B for information 

It is important to ensure high quality test connections (e.g. 
use IPS and IPDS Polar supplied microstrip probes) to 
minimise aberrations. 
The procedure for testing printed circuit boards is similar to 
that described for the sample tests earlier. 
Select a test file if one exists (or create a new file and insert 
tests for each controlled impedance on the board. Each test 
will include a complete set of test parameters for the trace 
under test — see Section 5 — Editing Test Files). Select the 
test to be executed (usually the first test in the list). 
Connect the tip of the Microstrip probe to the board terminals 
or connections (be careful to maintain correct polarity of signal 
and ground connections). See 3-1 Testing the sample coupon 
traces 
Execute the tests via the Board menu or click the Test button 
(see note below). 
If data logging has been turned on, when all tests for the 
board are completed supply board details for data logging in 
the Datalog Board Information dialog box. 
Note: For convenience, users are recommended to use the 
Foot Switch to operate the CITS880s in a “hands-free” mode. 
Using the Foot Switch allows the operator to use both hands 
to hold the probe in proper contact with, and support, the 
board under test). 
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Selecting a test file 
Prior to testing a board or batch of boards a test file 
containing tests associated with the board type must be 
selected (or created if none exists.) See Section 5 — Test 
Setup Editor. 
Select the File menu and the Open... command — the 
CITS880s displays the Open dialog: 

 
Figure 4-16  Selecting a test file 

The Open dialog opens with the list of files (identified by the 
.cif extension) in the current folder displayed. (Test files may 
also be selected from the recently used file list from the File 
menu.) 

Choosing a CITS880s test file via a bar code reader 

 
Scan Barcode 

Barcode readers often employ a USB interface so can be 
plugged in to an empty USB slot on the host computer 
without rebooting the host and generally need little 
configuration. powered directly from the USB interface,. 
The CITS880s Scan Barcode dialog can be utilised to scan 
the barcode for the item to be tested and load the 
associated CITS test file from the CITS880s test files 
folder. Click Scan Barcode to initiate the scan 

 
Both CITS native .CIF and XML test files can be loaded via 
the barcode reader. 
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(Accessing the Polar web site via the barcode reader 
Scan the QR codes ® in the Scan Barcode dialog to access 
Application Note AP629 Using barcode readers in Polar 
products or go to the Polar web site home page. 

QR Code ® is a registered trademark of DENSO WAVE 
INCORPORATED) 

With the test file loaded, click on the first test. 
The CITS880s displays the name of the selected file in the 
Title Bar and the first test’s impedance and distance scales 
and test limits in the Waveform Display window pane. 
From the Datalog menu click on Autolog to turn automatic 
data logging on and select Auto Advance and choose After 
Test to step through the tests automatically and log results to 
the log file. 
Select the test to be run and run the test. 
The Auto Advance function controls how tests in the test file 
are sequenced. Autoloading is controlled using the options in 
the Auto Advance sub-menu — Off, On Pass, After Test. 
If Auto Advance is turned Off the CITS880s will not 
automatically sequence through the tests. Steps in the 
sequence must be manually selected then run. 
If Auto Advance is set to After Test the CITS880s will 
sequence automatically through the tests, regardless of test 
results. 
When Auto Advance is set to On Pass the next test file in 
the sequence is automatically loaded if the current test 
records a PASS. 
To advance to the next test in the list manually, use the 
mouse or the arrow keys on the keyboard. 

Executing the Test 
Important: Use only the precision cables supplied by Polar 
Instruments; the CITS880s is calibrated using the supplied 
Polar cables (labelled with the channel numbers). Use of any 
other cables will invalidate the calibration of the CITS880s. 
Most board testing will be performed with Polar microstrip 
probes. Using microstrip probes minimises measurement 
errors due to mismatch between the impedance of the 
measurement system (50Ω) and the track under test. 
Keep to a minimum the number of changes in impedance 
between the CITS880s and the PCB track. For more 
information and hints on testing PCBs and test coupons see 
the notes at the end of this section. 
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Locate the microstrip probe in position on the circuit board 
under test (or coupon). Connect the signal pin to the signal 
trace pad and the ground pin to the ground plane (reference 
plane) pad. 
Hint: On test coupons the signal and ground pads can be 
identified by shape (signal pins pads are commonly round in 
shape, ground pins square.) 
Select the Test function from the Board menu (or click the 
mouse on the Test button or use the Foot Switch for hands-
off operation). 
When the test screen is displayed the limits of tolerance 
defined in the test for the tested portion of the track will be 
indicated by the intermediate and cross-hatched areas (at 
installation the CITS880s test window is set to its default – a 
green PASS area, an orange INTERMEDIATE area and red 
cross-hatched FAIL area on a black background — see the 
Utilities menu for information on changing screen colors). 
During a board test the system checks that the impedance 
waveform falls within the limits defined in the test file. 
Select the first test and test the first impedance trace; the 
results are displayed on screen and added to the log and the 
CITS880s selects the next test in the list (in Auto Advance). 
Test each of the traces on the coupon. 
As each group of tests is completed (i.e. when the whole 
board has been tested) the Board Information box is 
displayed so that board information may added to the test 
results and logged. 
Data in the log may be processed by the optional Datalog 
Report Generator. 

Deleting test results 
From the Board menu select the Clear All Waveforms 
command to clear all test data from the current set of results. 
Caution: Selecting Clear All Waveforms will clear all result 
entries from the Test List window pane and all unlogged data 
from the Datalog window pane but will not remove logged 
data. 
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4-9 Logging Test Data 
The Datalog function tests and records the results of a series 
of tests on a board or batch of boards. CITS880s creates a log 
file (a text file containing test data) for archiving and later 
analysis. The log file is stored in delimited form (using the | 
character as the delimiter between fields.) This format will be 
found suitable for import into most spreadsheet or database 
programs — and can be printed out for hard copy. 
Polar Instruments supply a Datalog Report Generator 
accessory to automatically process this data for use in 
statistical process control. To enable logging select the 
Datalog menu and ensure Autolog is turned on. Test the 
board using the test file; when the test is complete, the 
Datalog - Board Information dialog box is displayed — 
Figure 4-7. (For details of creating user-defined fields, e.g. 
Batch, Process, Type, etc., see SYSTEM CONFIGURATION.)  

 
Figure 4-7  Datalog information dialog box 

Enter the details for the board under test — serial number, 
date code and operator name, etc. and press OK. 
To save waveforms and snapshot automatically during 
logging click the Save all Waveforms as CVF (.cvf files) and 
Save Snapshot check boxes; waveform and snapshot files 
will be saved automatically at the datalog point. Files will be 
saved and named using the board serial number and test 
name (e.g. SN-0082.snap, SN-0082 Test50Ohm.cvf). 
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The Data Log window 
The Data Log window displays all logged entries in the log file. 
Test results are stored sequentially as records in the log file. If 
necessary, use the scroll bar to scroll through the list when 
inspecting records in the log. Each entry comprises a subset of 
the logged data — board details, test name, trace layer, the 
result of each test, average impedance and test date and time 
are included by default. Columns for Maximum impedance, 
Minimum impedance and Standard Deviation have been added 
to the Datalog window pane. 

 
Figure 4-17 Datalog window pane with logged data 

To include other information such as statistical data and test 
parameters right click into the Datalog window pane and 
choose Select Columns. 

 
Figure 4-18 Select Datalog display columns window 

Choose the fields containing the statistical data or test 
parameters and click Add then OK — the new fields will be 
added to the log window. 
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Deleting records 
To delete a single record from the log file, scroll through the 
list of entries, select the record with the mouse or the 
keyboard cursor keys and press the Delete button — all the 
tests for the board will be deleted. 
Note: The record will be permanently deleted. 

Editing records 
Each line of logged data (a small yellow circle is shown 
against data not yet logged) can be edited if necessary (e.g. 
to correct for the results of spurious readings, intermittent 
connections, etc.) with the Edit Line command. The Edit 
Line command is “greyed out” for data not yet logged. 
Right click onto the line to be modified and choose Edit Line 
to display the Edit Datalog Line dialog box. 

 
Figure 4-19 Edit Datalog Line dialog box 

The Datalog field box lists the columns (fields) displayed in 
the Datalog window. 
Choose the Field to be edited. 
Select a value from the New Value list or type a new value in 
the New Value box to replace the entry in the Old Value text 
box. Press OK to confirm the new value. 

Printing logged data 
To print the complete datalog right click into the Datalog 
window pane and choose the Print command from the short 
cut menu. To print only selected lines use the left mouse 
button + Shift or Control to select the lines required. 
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4-10 Using Delta Time Cursors 
Propagation delay times may be measured by positioning the 
cursors at the beginning and end of the test specimen. 
To enable the cursors select Cursors from the View menu 
or from the Waveform Display short cut menu. 
To position a cursor click the left mouse button on the cursor 
(the mouse pointer changes to a double headed arrow); drag 
the cursor onto the required location on the waveform. 
Release the mouse button. 
The screen displays the impedance value along with the time 
or distance from the waveform start where each cursor 
crosses the impedance waveform. 
The cursor readings, Propagation time, Delta time and 
Distance between the cursors are displayed at the top of the 
waveform window. 

 
Use the Snap Test Limit to Cursor command to reassign 
the Test From: and Test To: distances to the displayed 
cursor positions. 

Snapping test limits to Percent between cursors 
Use the Snap Test Limits to Percent between Cursors 
command to change the horizontal Test From and Test To 
limits to percentage values of the current lower and upper 
cursor time positions.  
Use Set Percentage Limits dialog box to specify the Test 
From and Test To limits 

 

For example, if the cursors are set to test from 2 to 8 inches 
(a 6 inch test range) using the above values will change the 
lower limit to 3.2 inches (2 + 1.2) and 6.8 inches (8 – 1.2). 

4-11 Viewing differential waveforms 
By default only the differential impedance waveform is 
displayed. During differential testing, however, the CITS880s 
records the differential impedance of the pair of traces, the 
single-ended impedance of each line to ground and the 
differential even mode impedance of the pair. 
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Results for odd and even mode impedance, crosstalk and 
unbalance between the lines are logged and displayed on 
screen. The results displayed by the CITS880s take into 
account the effect of unbalanced lines. 
To view the single-ended and even mode waveforms (e.g. 
for engineering analysis) select Show Differential 
Waveforms (right-click the waveform window to display the 
short cut menu). 

 
Figure 4-20 Waveform window showing differential waveforms 

Offset the display vertically using the up and down arrows (or 
mouse wheel) to display all waveforms. The display above 
shows the 100Ω differential impedance waveform along with 
the reference waveform (shown in green), two single-ended 
waveforms (approximately 53Ω) and the even mode 
waveform (approximately 58Ω). 

Attaching cursors to waveforms 
The cursors can be used to display values along each of the 
waveforms. Select the Attach Cursor To command and 
from the sub-menu choose the waveform to be measured. 

 

The color of the cursors changes to the color of the chosen 
waveform. 
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Calculating waveform slope 
Series resistance will appear as a ramp in the waveform with 
impedance increasing linearly with distance. Series 
resistance simply adds to the characteristic impedance over 
the length of the waveform. (See the section Test Editor|DC 
resistance compensation for a brief discussion of DC 
resistance compensation.)  
Series DC resistance can be compensated for by adjusting 
the slope of the waveform by a specified number of 
ohms/horizontal unit. This cancels out the series resistance 
leaving the true characteristic impedance displayed. 

Applying DC resistance compensation 
Caution! Applying DC resistance compensation may 
invalidate results. 
A sloping waveform may be attributable to a number of 
causes. Consult the board design authority before applying 
DC resistance compensation. 
Right-click the waveform display window and choose the 
Calc and apply slope of Test Region command: the 
CITS880s displays the slope of the waveform within the test 
region along with the horizontal position (i.e. the distance) of 
the first cursor. 

 

To apply DC resistance compensation locate the first cursor 
at the horizontal distance DC resistance compensation 
should begin. Click Yes to apply the values for DC resistance 
compensation and start point, click No to leave the data 
unmodified. 
The waveform is shown with small triangle added at the 
beginning of the compensated portion of the waveform. To 
remove the compensation start the Test Setup Editor (right 
click the waveform or the test name in the test list and 
choose Edit…) and reset the DC resistance Compensation 
setting to Default. 
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Launch point extrapolation 
The CITS880s supports launch point extrapolation (LPE.) 
LPE applies a regression line fit to a stable sample of the 
reflection from the trace and projects this regression line 
back to the launch of the trace. LPE can better reflect the 
impedance that the signal sees as it launches into the trace. 
This can be beneficial with thin copper and narrow traces. 
To define LPE limits, using the Test Editor, define the target 
impedance, the test region and associated limits and the 
distance along the trace for each of the LPE points. 

 

The CITS880s displays the slope of the trace over the test 
region extending the line (and displaying the values) through 
the extrapolation points (shown as error bars in Figure 4-12.) 
See Section 5 Test Editor – Launch point extrapolation. 

 
Figure 4-121 Launch point extrapolation slope and test points 

Click the i  button to access Polar Application Note AP8505 
on the Polar Instruments web site for further information on 
launch point extrapolation. 
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4-12 Printing waveforms, datalog or test results 
Select the Print function from the File menu. 
The Print dialog box includes the Select Printout group of 
options — choose Waveform, Datalog or Test List for 
printout. Use the text box to add comments to the printout. 
See Figure 4-13. 

 
Figure 4-14 Print dialog box 

Select OK to proceed with printing. 

4-13 Saving and viewing waveforms 
The Save Waveform function allows the operator to store 
individual test waveforms on disk. Test waveforms are stored 
as files with the .cvf file extension. With the waveform 
displayed in the Waveform Display window pane select Save 
Waveform from the Waveform menu —the system will 
display the Enter Waveform Filename dialog box. 

 
Figure 4-22 Save waveform dialog box 
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Choose a name for the waveform and press Save — the 
CITS880s displays a Notes text box; add comments (board 
serial number, date code, the operator’s name, etc.) and 
press OK. 
To overwrite a previously stored waveform select the name 
of an existing waveform file from the list and press OK. 

Saving waveforms as csv files 
Click the Save Waveform as CSV command to save the 
waveform in comma separated text format suitable for 
importing into text editors, spreadsheets and databases. 

Viewing recorded waveforms 
Waveforms stored on disk with the Save Waveform function 
may be retrieved and printed with the File Open command. 
Select Open from the File menu — a list of previously 
recorded waveforms is displayed. Use the cursor keys or the 
mouse to highlight and select a file from the list and press 
OK. The CITS880s displays the stored waveform and 
associated statistics; results may be printed out using the 
Print command as described earlier. 
The items displayed in the Waveform Display window pane 
can be controlled via the View menu (or the Waveform 
Display short cut menu.) Select items for display (readout, 
cursors, etc.) as necessary. 

Clearing the waveform screen 
To delete the waveforms and test results from a test, select 
the test from the test list and use the Clearscreen command  

4-14 Reference Waveforms 
The CITS880s incorporates the facility to store a reference 
waveform as part of the definition for each test in a file; the 
reference waveform is displayed, e.g. as an example of a 
good trace, when the test is selected. 

Setting a Reference Waveform 
With a good waveform displayed, to save the current 
waveform as the reference waveform for a test use the Save 
Reference command from the Waveform menu. The 
waveform is then displayed whenever the test is selected. To 
make this change permanent save the test file and reference 
to disk using the Save command from the File menu. 

Viewing a Reference Waveform 
To view the current reference waveforms for the tests use 
the View References command from the Waveform menu. 
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4-15 Overlaying waveforms 
The Overlay command from the Waveforms menu allows 
waveforms from a series of test operations to be 
superimposed, or overlaid. The Overlay option displays a 
sub-menu from which the user specifies the number of 
waveforms to be superimposed — 2, 5, 10, 20 or 50. 
With the Overlay option selected, the waveform window is 
not cleared between board tests. The results of the last 2, 5, 
10, 20 or 50 tests will appear superimposed until Overlay is 
deselected (set to Off) — when the maximum number of 
overlays is reached the oldest test result will be discarded 
first. See Figure 4-15. 

 
Figure 4-23 Waveforms superimposed in Overlay mode 

Test the board or batch of boards as described earlier — the 
test waveforms from each test operation will be overlaid on 
the previous waveforms until Overlay is switched off. 
Note: the PASS/INTERMEDIATE/FAIL result and information 
appearing in the Statistics area ONLY refer to the most 
recent test. The Statistics area does not accumulate data. 
Turn Overlay off to clear the overlaid waveforms. 
Note that the last test result is not cleared — if necessary 
use Clearscreen to clear the screen. 

4-16 Exiting the CITS880s program 
Select Exit from the File menu to leave the CITS880s 
program. 
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SECTION 5 — EDITING TEST FILES 

TEST PARAMETER FILES 

EDITING TEST FILES 
Each board type to be tested is tested in accordance with 
one or more tests each of which includes a set of test 
parameters. Typically the set of tests for one board type will 
be stored in a single test file. 
For example, the coupon test files contained the tests for the 
sample coupons supplied with the CITS880s. The diagram 
below illustrates the test parameters specified in a test. 

 
Figure 5-1 Test parameters defined in a test  
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Test parameters 
In Figure 5-1 letters P, A, B, T signify the test parameters 
listed below: 
 
P = Probe Length 
A = Test From 
B = Test To 
T = Tested region (B – A) 
The test parameters will be defined in the Test Setup Editor. 
The Test Editor contains setting for probe lengths and 
coupon test regions, impedance values and tolerances and 
test types (i.e. single-ended or differential) and test methods 
along with limits for unbalance between lines and crosstalk. 
The Test Editor also includes parameters for the CITS880s 
launch point extrapolation (LPE) which uses line fitting to the 
TDR trace.  
LPE parameters comprise target impedances and limits for 
each of the LPE points (set at user-selectable distances 
along the TDR trace.) 

5-1 The Test Setup Editor 
Test parameters for boards under test may be defined or 
modified using the integrated Test Setup Editor. 
See Figure 5-2. 

 
Figure 5-2 The Test Setup Editor 
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5-2 Creating and modifying test files 

Creating a new test file 
To create a new test file choose the New command from the 
File menu. This will display the Edit Board Details dialog 
box; this dialog will be displayed each time a new batch of 
tests (i.e. a new board type) is created. 
Enter the details for the board under test, Customer, Board 
Type, Part Number and Revision Number and notes. 

 
Figure 5-3 Edit Board Details dialog box 

Press OK to create the new (empty) file. Add tests to the file 
via the Insert command as described below. 

Inserting tests 
Select the Insert command from the Board menu (or press 
the Insert key) — the Test Setup Editor (Figure 5-2) is 
displayed. 

 Test Editor icon 

Each parameter is defined and displayed in a parameter 
field. To create or edit a test, modify the test parameters as 
required and then use the OK button to confirm the field 
edits. The fields are described in the following sections. 
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5-3 Board test parameters 
Entries in the fields contained in the Test Setup Editor will be 
available for display in the Test List and Datalog and printed 
out with the test results. 

 

Description 
Enter the test type into the Description field (e.g. D-1, 50 
Ohm Trace, etc.) The Description is included as part of the 
data for a board.  

Layer 
Use the Layer field to indicate the trace layer (e.g. L1) 

Impedance 
Use the Impedance field to define the nominal impedance in 
ohms of the PCB track under test. 
This field must contain a number of up to 4 significant digits 
in the range 10.10 – 200 Ohms. 

Adding a structure graphic 
Click Edit Structure to Display the Structure Selector dialog. 
Select the structure graphic to be added to the test file 

 
The graphic will be saved with the test file. 

Probe Channel Select 
Use the Probe Channel Select function to specify the 
CITS880s channel or channels to be used for the test. 
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Specify any of the four channels for single-ended tests or for 
groundless differential tests. For differential tests use 
Channels 1 & 2 and Channels 3 & 4. 
The chosen test type will be reflected in the structure 
Selector window (See Edit Structure below.). 

Click the i  button to access Polar Application Note AP8507 
on the Polar Instruments web site for further information on 
groundless differential probes. 
 

Single-Ended Tests 
To perform a single-ended test click the Single-Ended Test 
option button and click the channel number check box. 
Important: Use only the precision cables supplied by Polar 
Instruments; the CITS880s is calibrated using the supplied 
Polar cables labelled with the channel number and 
instrument serial number. Use of any other cables will 
invalidate the calibration of the CITS880s. 
To perform single-ended testing, connect a probe cable to its 
corresponding CITS880s channel and connect the IPS 
Microstrip probe to the probe cable. 

Differential Tests 
To perform a differential test, click the Differential Test 
check box. In order to perform differential measurements the 
CITS880s uses Channels 1 & 2 and Channels 3 & 4 as 
differential channels. Differential testing is performed using 
the IPDS100 Differential Probe. For differential testing, 
connect the differential probe to Channels 1 & 2 or Channels 
3 & 4 using the supplied cables. Use the Channel combo box 
to specify the CITS880s channel pair. 
Note: It is critical for a differential test that the probe cabling 
for both channels is of matched impedance and length. 

Groundless Differential Tests 
Note: It is essential that groundless differential tests are 
performed with the Polar supplied groundless differential 
(GDPS) probes. 
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Polar GDPS probes are designed to allow the CITS880s to 
measure the impedance of balanced differential traces 
without the need to make a ground connection to the board 
or coupon under test. They may prove useful for situations 
where access to the ground plane of the PCB is 
impracticable or where there is a need to test a balanced 
differential pair such as a broadside coupled surface trace on 
a flex circuit. 
Click the Groundless Differential Test check box.  
Setting up the end of probe and the test region needs to be 
done with care. For the groundless differential probe an end 
of probe setting of 8 inches is recommended.  
To determine the end of probe with greater precision, verify 
at a short and not at the open circuit of a probe held in the 
air. Begin with the probe length set to zero, place the probe 
on a conductor so that both pins are shorted then scroll the 
trace up so that the point at which the trace levels off at near 
zero can be seen. Take the probe length from that point. 
To set the test region, pick the flattest portion of the test 
trace before the trace goes to the top of the screen where 
the open at the end of the trace is detected. 
Please note: Even though they may look like ordinary single 
ended IP probes and have only one precision probe cable, 
Polar groundless differential probes are not capable of single 
ended measurement. 

Selecting a structure graphic 
Click the Edit Structure button to add a thumbnail graphic of 
the controlled impedance structure for the test. 

 

Scroll to the associated structure graphic and click OK – the 
graphic chosen will be displayed in the waveform window 
along with the test limits, waveform(s) and test results. 
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Horizontal Units 
The horizontal axis on the Waveform Display screen can 
display either distance along the trace under test or “real (i.e. 
out and back) time”. Click on the drop down list box arrow to 
display the units available: 

 

The Units field specifies the units (Feet, Inches, Millimeters, 
Meters, Nano-Seconds and Pico-Seconds) that will be used 
for the Test From, Test To and Probe Length fields. It defines 
the units used to specify all the distance or time parameters 
and those used on the horizontal axis of the displayed 
waveform. If time units are selected the Waveform Display 
window displays “real time”, i.e. the “out and back” time for 
the TDR pulse. 

Tolerance 
Set the tolerance levels for PASS and FAIL; in the dialog 
shown below, the Intermediate option has been selected to 
provide a guard band between PASS and FAIL. Readings of 
±8% from the nominal impedance constitute a PASS; 
readings greater than ±8% but less than ±15% from nominal 
return an INTERMEDIATE result; readings greater than 
±15% from nominal return a FAIL. 
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Click the Locked check box where Plus and Minus 
tolerances are to be locked to the same value, leave 
unchecked to set each value is set independently  
Note: when the Intermediate check box is ticked the Locked 
option is disabled. 
The tolerance must be set to a value in the range 0.10% to 
99.99% in 0.01% steps; alternatively, it may be set directly in 
Ohms. Click the % or Ohms option buttons to select. 
Choose Enable Max-Min to specify in ohms the maximum 
range of impedance values over the tested waveform. 

Setting the Unbalance Warning Limit 
During differential testing the CITS880s checks the single-
ended impedance of both signal lines. The CITS880s logs the 
percentage difference between lines and issues a warning if 
the unbalance exceeds the threshold set in the Unbalance 
Warning Limit field. Use the Unbalance Warning Limit 
field to set the limit as required. 

Display Width 
Use the Display Width control to specify the horizontal time 
or distance scale maximum. 

 

The horizontal axis will extend from 0.0 to the specified value. 
Display Width distance values can vary from 2.50 – 100 inches 
(0.02 – 7.0 feet, 0.065 – 2.0 metres, 65 – 2000 millimetres;) 
Display Width time values can range from 0.6 – 22.0 
nanoseconds (600 – 22000 picoseconds.) 

Setting Display Width automatically 

If the Display Width is set to Default the display width is 
automatically adjusted for the most meaningful waveform 
display each time the Test From and Test To settings are 
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changed. (To prevent this autoscaling, choose a Display Width 
setting from the range of numerical values – the display width 
will remain fixed regardless of the Test From and Test To 
settings defined for the test.) 

Autoscale 
Use the Autoscale function to choose the optimum horizontal 
display width. The CITS880s will use the waveform under 
test to calculate the width that should give the most 
meaningful display. 

 

Click the Autoscale button – the CITS880s will prompt for a 
test on the associated coupon trace. 

 

Run the test on the trace – the CITS880s will use the 
impedance waveform to decide the optimum display width. 

Test From 
This parameter, along with the Test To parameter enables 
the user to specify the length of trace or propagation time to 
be tested. This allows the user to avoid testing for controlled 
impedance in an area where the displayed waveform may be 
ringing (e.g. where a sharp change of impedance occurs in 
the test system connection). 
The Test from parameter specifies the distance or time from 
the start of the display to the start of the length or time over 
which impedance is to be tested (see Figure 5-1). 
It defines the start of the tested area within the display 
window. 
Test from may be set in the range: 
Distance 
0 to 78 inches 
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0 to 6.5 feet 
0 to 2 meters 
0 to 2000mm 
Time 
154.04nS 
154040pS 

Test To 
The Test To parameter specifies the distance or time from 
the start of the display to the end of the length or time over 
which impedance is to be tested (see Figure 5-1).  
It defines the end of the tested area within the display 
window. It is important to set Test From and Test To to 
define part of the undisturbed interval in the display. 
Test to may be set in the range: 
Distance 
0 to 78 inches 
0 to 6.5 feet 
0 to 2 meters 
0 to 2000mm 
Time 
154.04nS 
154040pS 
Note that Test To must be greater than Test From. 

Probe Length 
The Probe Length field specifies the distance or time from 
the end of the CITS880s cable to the beginning of the 
displayed graph on the PC (see Figure 5-1). 
Probe length may be set in the range: 
Distance 
0 to 78 inches 
0 to 6.5 feet 
0 to 2 meters 
0 to 2000mm. 
Time 
154.04nS 
154040pS 



 

CITS880s User Guide TEST PARAMETER FILES • 93 

DC Resistance Compensation 
Caution! Applying DC resistance compensation may 
invalidate results. A sloping waveform may be attributable to 
a number of causes. Consult the board design authority 
before applying DC resistance compensation. 

Applying DC resistance compensation for series loss 
The DC resistance Compensation field may be used to 
compensate for series DC resistance in the track being 
tested. 
Any series resistance will appear as a ramp in the waveform 
with impedance increasing linearly with distance. Series 
resistance simply adds to the characteristic impedance over 
the length of the waveform. This phenomenon is caused by 
the DC resistance of the track combined with high frequency 
skin effects reducing the effective cross-sectional area of the 
track. 
Series DC resistance can be compensated for by adjusting 
the slope of the waveform by a specified number of 
ohms/horizontal unit. This cancels out the series resistance 
leaving the true characteristic impedance displayed. 
Note: Series DC resistance may be distinguished from the 
case of a slightly tapered track by testing from both ends of 
the trace. In the case of series DC resistance the impedance 
waveform will appear to have the same rising slope when 
tested from both ends.  
For normal use it is suggested that DC resistance 
compensation should be left in the default state — disabled. 
In some instances, however, where long conductors or those 
with small cross sectional area are being tested enabling DC 
resistance compensation may prove useful. 
Select User to display the DC Resistance Compensation text 
box then type in the desired value. 

 

See SPECIFICATIONS for the range of acceptable values. 

Velocity of Propagation (Vp) 
The Velocity of Propagation (Vp) is the speed at which 
electrical signals propagate along a cable or printed circuit 
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board trace. Vp is given as a percentage of the speed of 
light, c. 
The speed of the signal depends on the dielectric of the 
medium in which it travels. For simplicity of operation the 
CITS880s program assumes that all cables and PCB tracks 
have a velocity of propagation of 66% the speed of light. 
The CITS880s calculates displayed distance or time from 
time based on a default Vp of 0.66. This value will be found 
valid for typical coaxial cables and circuit board traces. 
This will, however, result in some apparent errors in the 
indicated distances and times in systems that have 
significantly different velocities of propagation. 
For example, airlines, which have a very high velocity of 
propagation (98–99% the speed of light), will appear shorter 
than their true physical length if both are measured with the 
default Vp. Since the purpose of the CITS880s is to measure 
impedance, for most applications the linear accuracy of the 
horizontal scales will probably not be critical. 
If desired, the Vp used for display of test waveforms can be 
adjusted for the display window. If Vp is correctly adjusted 
then the displayed electrical length of any tested specimen 
will match its physical length. This adjustment is applied to all 
of the displayed waveform. 
For most applications leave the Vp setting at Default. 
Selecting the User option displays a text box containing the 
current value of Vp. With the text box displayed use the left 
and right arrow keys or the mouse to locate the cursor and 
type in the desired value. 

Ohms per Division 
The vertical axis on the PC screen is scaled in ohms per 
vertical division. The scale may be set to one of the pre-
defined values 1, 2, 5, 10, 20 or 50 ohms/div. 

 
Click the dropdown list box arrow to select the vertical scale 
value. Choose the scale factor which gives optimum display 
— lower values display the waveform in greater detail. 
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Group Spread Test 
The test may be designated as part of a test group defined 
by the Board|Edit Groups… command. See Section 4-4 
Group Testing. 

 

To assign the test to a group click the Enable check box and 
select the group from the Group Name combo box.  

Crosstalk Limit Test 
For differential tests limits for allowable crosstalk may be 
applied to a test. Click Enable and supply the Crosstalk Limit 
value as a percentage. 

 

Values of crosstalk exceeding the limits specified in the 
Crosstalk Limit text box will result in a test FAIL. 

5-4 CITS880s Test Methods 
The CITS880s provides for several test methods to 
accommodate traces with different characteristics, for 
example, uninterrupted traces, traces with vias and traces 
exhibiting significant loss. 
The Absolute test method is the preferred test method and 
is selected by default. 

 

Absolute test method 
When the Test Method parameter is set to Absolute the 
CITS880s will record an INTERMEDIATE if the trace enters 
the INTERMEDIATE area at any point or a FAIL if the trace 
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waveform crosses the FAIL threshold (i.e. touches the 
crosshatch area of the test limits) at any point over the tested 
area. The Absolute method test window is shown below. The 
nominal impedance is 100 ohms, INTERMEDIATE 
impedance threshold is ±8% and the FAIL threshold is ±15%. 
Result values are shown to the left of the display window. 

 
Figure 5-4 Absolute Test Method display window 

Average test method 
(Retained for legacy applications) 

Note: The Average test method should only be used with the 
express approval of the specifying authority. 

The Average method sums the value of all the points within 
the horizontal test limits and divides by the number of points 
in that interval. 
Selecting Average will cause the test to fail only if the 
average impedance value (shown in the top left of screen 
statistics box) is out of tolerance. 
The Average test method is a method which was used for 
legacy backplanes. It was found useful when large numbers 
of via holes were likely to disturb the PCB trace impedance 
waveform. It is included from the days when risetimes were 
slower and backplanes designed with higher nominal 
impedance for the trace and the via capacitance used to 
“pull” the average line impedance down. 
When Average is selected the test limits (100Ω nominal 
impedance, ±10% between 2 inches and 6 inches) are 
displayed as shown in the diagram below: 
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Figure 5-5 Average Test Method display window 

The Average method is used most often when large 
numbers of via holes are likely to disturb the PCB trace 
impedance waveform. Typical examples include backplane 
and similar traces. 

Envelope test method 
Using the Envelope test method a waveform is acquired and 
used as a reference waveform. A user tolerance specified 
envelope is drawn around each data point in the tested 
region of the acquired reference waveform (as shown in the 
diagram below); each data point in subsequent acquired 
waveforms is tested against its associated envelope in the 
reference waveform.  
Click the Envelope method from the Test method option 
group. 

 

Specify the impedance and time or distance tolerances for 
the envelope; the size of the envelope is thus determined by 
the Tolerance settings – vertically in Ohms, horizontally in 
distance units, millimetres, inches, etc. or in time units, nano-
seconds or picoseconds. 
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When first run, the Envelope test method acquires its 
reference waveform; the CITS880s acquires the first trace 
and offers to save it as a reference 

 

A tolerance envelope is shown around each data point in the 
reference waveform in the diagram below; for the test to 
record a PASS each data point for a coupon under test must 
sit within its associated envelope. 

 
Fig 5-6 Envelope Test Method display window 
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5-5 Launch point extrapolation (LPE) 
Note: Launch point extrapolation (LPE) is IPC approved but 
should be used in conjunction with the express clearance of 
the specifying authority. 

Measuring instantaneous impedance on the CITS880s 
With thinner copper and finer PCB traces, TDR traces are 
often seen exhibiting an upward slope from left to right, the 
trace gradient increasing for fine trace widths or as the 
copper layer gets thinner. As the TDR reflection returns to 
the measurement system, a combination of DC and AC trace 
resistance adds to the reflection of the instantaneous 
impedance resulting in an upward sloping trace.  
The impedance calculated with a field solver is the 
instantaneous impedance, i.e. the impedance (if it were 
possible to slice through any point on the trace and apply an 
ideal TDR pulse) at the point of launch into the trace section.  
Launch point extrapolation applies a regression line fit to a 
stable sample of the reflection from the trace and projects 
this regression line back to the launch of the trace – hence 
launch point extrapolation. This technique requires a TDR 
with as flat a pulse as possible and, ideally, minimum leading 
edge perturbations. CITS880s supports this technique in 
addition to conventional impedance measurements for less 
challenging geometries. 
To define LPE limits, click Enable for each of the points and 
define the target impedance for each point. 
Note: the test limits and time position of the launch point and 
end point extrapolation are the primary responsibility of the 
PCB specifier and fabricators should seek their customers' 
guidance if in any doubt. 
The CITS880s uses the values defined in the Tolerance 
section of the Test Editor window to set the LPE limits. 
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Define the distance along the trace for each of the LPE 
points. The CITS880s uses the tolerance and distance 
values to draw the associated error bars on screen. 
The launch impedance (LPE Pt1) is typically set close to the 
launch, near the start of the coupon. 
LPE Pt2 is set further down the line (this could be past the 
end of the coupon) as a check that the slope is not too steep. 
Note: Some OEMs may prefer to set the limits for LPE Pt1 
and LPE Pt2 in time units and in this case the CITS880s 
editor should be set to display time rather than length. 

i   Information Click the information icon to access Polar Application Note 
AP8505 Instantaneous impedance measurement with LPE 
(Launch Point Extrapolation). 
As the test is run the CITS880s calculates and displays the 
slope of the trace over the test region and extends the line 
through the extrapolation points, fitting the line to a 
regression calculation of the data points between the Test 
From and Test To distances (below.) 

 
Fig 5-7 Launch point extrapolation (LPE) 
With all settings completed press OK to confirm the test 
parameters and close the Test Setup Editor. 
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5-6 Saving the test file 
  Press the Save button to 

save the file 
When all tests for the board under test have been specified 
press the Save button, or use the Save or Save As 
commands from the File menu, to store the file as a new test 
file. The system will display the Save As dialog box to 
request the new file name. 

Naming test files 
Names assigned to test files must conform to the Microsoft 
Windows conventions for file names. File names must be 
unique and may contain up to 255 characters. The following 
characters may be used in file names: 
  Letters A to Z and a to z 
  Numbers 0 to 9 
and the following special characters: 
  - ! $ % ^ & ( ) @ ~ # { } ` ' _ 
Operating system reserved characters such as slashes (/ \), 
question marks (?), asterisks (*) and less and greater than  
(< >) are not permitted in file names. For more information on 
file naming conventions, consult the Windows operating 
system user guides. 
It is recommended that users employ systematic test naming 
schemes in which tests are assigned descriptive names 

Saving test files under new names 
To save a file under a new name select the existing file using 
the Open command from the File menu, choose the Save 
As command and name the new file (if necessary edit the 
file). 

5-7 Using existing files as templates 
An alternative method of creating a new test file is to open an 
existing test file, save it under a new name and then edit it. If 
this is a new test file, select a suitable existing file and edit 
the parameters for each test as required. 

5-8 Printing test files 
To obtain hard copy of test files (e.g. for reference or 
customer conformance reports) right click the Test File 
window pane (or select the Print command from the File 
menu (or press Ctrl-P). 
The Print function will print to the default Windows printer. 
Click the Print Preview command to inspect the printout prior 
to printing. 
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SECTION 6 — MAINTENANCE AND FAULT FINDING 

MAINTENANCE AND FAULT FINDING 

6-1 System check 

Single ended tests 
From the File menu create a new test file. 
From the Board menu Insert a new test. When the Test 
Editor opens, type Ch1 in the Description box, change Probe 
Length to zero and Tolerance to 5%.  
Repeat for Channels 2 to 4, supplying an appropriate 
description for each and selecting the appropriate test 
channel. 

Differential tests 
Create another new test and enter description “Differential 
CH1/2”, select Differential and Channel “Ch1 & Ch2”. 
Change Probe Length to zero and set Impedance to 100 
ohms 
Create a similar differential test for channels 3 and 4. 
From the Utilities menu click on Relay and Cable Test and 
agree to the tests being added. 
With nothing attached to the cables (ensure these are the 
test cables that will normally be used with the CITS) run the 
Learn Cable Length from the Utilities menu and then run the 
four cable and relay tests. 
Attach the calibrated semi-rigids supplied with the CITS880s 
to the appropriate cables and run the 6 tests created. 
Save the test file for future use. 

6-2 Cable Replacement 
Whenever cables are replaced on a system the CITS880s 
should be recalibrated. Failure to do so may result in the 
instrument not meeting specifications. Return the CITS880s to 
your Polar Service Center for calibration. 
Should the power supply cable need replacing ensure that the 
new cable is sourced from Polar Instruments to be certain it 
fully complies with all safety requirements. Use of an 
inadequate cable could cause a hazard to employees or 
damage to the instrument. 
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6-3 CITS880s Servicing 
 

WARNING This instrument should only be serviced by a qualified 
electronics technician. 

 
IMPORTANT The CITS880s is an extremely sensitive measuring 

instrument. 
To prevent damage to the CITS880s observe static precautions at all 

times. See Appendix B for information 

 
Refer all servicing to qualified service personnel. There are 
no user serviceable parts within the instrument enclosure. 

Microstrip probes 
If a different pitch between the ground and signal pins on the 
Microstrip probes is required this may be adjusted with the 
aid of a soldering iron. (In the event of damage or loss to the 
spring loaded pins, replacements are obtainable from I.D.I or 
their local agents. The order code is SS 75E 4.9 G) 

Cleaning 
Clean the instrument with a cloth lightly moistened with water 
with a small amount of mild detergent. Alternatively, a cloth 
lightly moistened with alcohol (ethanol or methylated spirit) or 
isopropyl alcohol (IPA) may be used. 
Do not spray cleaners directly onto the instrument. 

Technical Support 
For technical support contact your local Polar Instruments 
distributor or Polar Instruments. See front cover for email 
address and fax numbers. 

Consumable parts 
Cables and probes should be replaced every two years or 
when showing signs of significant wear. 
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6-4 Fault diagnosis 
The following symptoms may be investigated by the user. 
More serious faults should be referred to qualified personnel. 
 

Symptom Test 
Communication Error 
reported by the host 
computer 

Check CITS880s power is switched on. 
Check CITS880s BUSY LED is lit for a few seconds on 
power up then extinguished. If the LED stays lit or turns 
red, the CITS880s is faulty; refer to the supplier or agent 
Check the connection of CITS880s to the PC meets the 
USB 2.0 specification (check for "Enhanced" USB 
Controller in the Universal Serial Bus section of 
Windows Control Panel|System|Hardware|Device 
Manager.) 
Check that the USB 2.0 cable used is the cable supplied 
with the CITS. 
 

CITS880s displays 
USB power warning 

Check that the USB 2.0 hub is not shared with a high 
powered USB accessory. 
 

Foot switch not working Check that the Foot switch is plugged in to the host 
computer. 
 

Printer fails to work Check the printer is switched on. 
Check connection of the PC to the printer. 
Print a window test page for the printer. 
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APPENDIX A 

CHARACTERISTIC IMPEDANCE OF CONDUCTORS 

The characteristic impedance of a conductor is a function of 
the dimensions of the conductor, its surrounding environment 
and the dielectric constant Er of the insulating material. 

 
The diagram below includes equations for calculating the 
characteristic impedance of coaxial cable, microstrip and 
stripline. 

 
Figure A-1 Typical conductors and associated impedance equations 
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Figure A-2 Reflection magnitude v discontinuity impedance for a 50Ω Zo, step output TDR 

Determination of characteristic impedance 
The CITS880s displays a graph of the characteristic 
impedance of a specified length of PCB trace. This is 
achieved by calculating the impedance along the length of 
the cable or PCB based on the size of the reflections 
measured using time domain reflectometry. 
The above graph shows the size of reflection from an 
impedance discontinuity encountered by the out-going pulse 
of a 50Ω, step output TDR such as the CITS. 
The CITS880s software translates the magnitude of voltage 
reflections measured by the TDR into a linear plot of 
impedance against distance. Note that the size of the 
reflection is not linearly related to the impedance 
discontinuity. As the impedance gets larger the slope of the 
curve is reduced so that at high impedances a large change 
in impedance will only cause a small change in reflection. 
Consequently the accuracy of measurements of high 
impedances is reduced. 
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APPENDIX B 

ELECTROSTATIC DISCHARGE 

PROTECTING THE CITS880s FROM ELECTROSTATIC DISCHARGE 
 

Caution: The probe/input circuitry of the CITS880s includes sensitive 
components that are susceptible to damage from electrostatic discharge — 
precautions must be taken to avoid static discharge into the probe. 

 
Many of the components in modern instruments like the 
CITS880s employ internal construction that may be 
damaged by electrostatic discharge (ESD). Such 
components are often referred to as static sensitive. 
Damage caused by electrostatic discharge may be severe 
enough to result in the complete and instant failure of a 
component. Often, however, components are not destroyed 
but merely degraded and failure occurs in later use.  
Some devices are sensitive enough to be damaged or 
degraded by electrostatic discharge of only several tens of 
volts, voltages not uncommon at unprotected workstations. 
Everyday activities such as applying tape from a dispenser, 
walking across nylon carpets or separating plastic 
transparency films can generate charges of several thousand 
volts. 

Sources of static electricity 
There are two sources of static electricity most likely to be 
encountered by the technician: 

People (especially when wearing clothes made from 
synthetic fibre). 
Packaging materials such polythene (e.g. bags or tubes), 
polystyrene containers or padding (e.g. chipples, etc.) 
and adhesive tape used to seal containers. 
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Static free workstations 
Static sensitive components, including completed circuit 
boards, should only be used (i.e. inserted or replaced) at a 
static free workstation. The static free workstation will 
typically include anti-static bench mats, floor mats and wrist 
straps and should be kept free from materials which could 
generate or store a static charge. 

Working with the CITS 
When using the CITS880s observe the same procedures as 
when handling static sensitive components: 
Use the CITS880s at an approved anti-static workstation. 
Wear a wrist strap connected to a suitable earth point. A 
wrist strap is provided with the CITS880s (connect the wrist 
strap to the stud on the CITS880s front panel). 
Other protective clothing, such as conducting heel straps and 
metallised coats can be worn if available. 
Keep materials that may produce static electricity away from 
the workstation. 
Treated completed circuit boards as static sensitive 
components. 
Avoid dragging the CITS880s probes across work surfaces. 
Do not point the probe tip at surfaces that may have a static 
charge, e.g. monitor screens. 
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APPENDIX C 

STATUS OUTPUT CONNECTOR DETAILS 

Pin  Name Description (all outputs are open-collector) 
1 Pass On if test passes 
2 /Pass Off if test passes 
3 Fail On if test fails 
4 /Fail Off if test fails 
5 Testing On during testing 
6 /Testing Off during testing 
7 Strobe Turns On to strobe Pass and Fail outputs 
8 /Strobe Turns Off to strobe Pass and Fail outputs 
9 Common Common line for all outputs 

 
Note: All outputs are opto-isolated from ground. For continued safety do not elevate any 
pin to more than +/–30V DC relative to ground. 
Output transistors are NPN with open collectors connected to pins 1 to 8. Emitters are 
all commoned to pin 9. 
Maximum collector to emitter voltage is 15V enabling interfacing to most logic families. 
The outputs cannot drive relays directly.
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APPENDIX D 

USING BARCODE READERS IN POLAR PRODUCTS 

Using barcodes in Polar products 
Barcodes are used in Polar products, e.g. CITS880s Controlled Impedance Test System 
to choose test files and to link to the Polar web site and display application notes. 
A barcode is a method of representing data in machine-readable form. Fast and 
accurate data capture can reduce errors and increase productivity. 
Several Polar products incorporate the option to utilise barcode readers for rapid and 
reliable interaction with the application. The barcodes used in Polar products range from 
linear 1D barcodes to 2D QR (Quick Response) Codes ® 

 
Linear barcode 

 
QR Code® 

Barcode readers 
Barcode readers are readily available and inexpensive – the barcode reader illustrated 
below is widely obtainable online as a computer accessory at low cost 
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Choosing a CITS880s test file 
The CITS880s Scan Barcode dialog can be utilised to scan the barcode for the item to 
be tested (for example, a controlled impedance test coupon) and load the associated 
CITS test file from the CITS880s test files folder. Both CITS native .CIF and XML test 
files can be loaded via the barcode reader. 

Accessing the Polar web site 
Scan the QR Codes® in the Scan Barcode dialog to access Application Note AP629 or 
go to the Polar web site home page. 
Barcode readers often employ a USB interface so can simply be plugged in to an empty 
USB slot on the host computer without rebooting the host and generally need little 
configuration. In addition, they are generally powered directly from the USB interface, so 
do not require extra power supply cables. 
QR Code® is a registered trademark of DENSO WAVE INCORPORATED
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APPENDIX E 

NOTES ON USE OF POLAR XML INTERFACE FOR CITS 

March 2019 
From CITS Version 18:05 provision is provided to read a simple XML file that the CITS 
software can then create a native test file (.cif) from. 

This document is the format specification for the source XML file that needs to be 
created by the user of this feature. 

The overall structure of the XML file is very simple, in fact the following file will 
generate a testfile with three default tests in it:– 

 

<?xml version="1.0" encoding="UTF-8"?> 
<PolarXML> 

<Header></Header> 
<Setup></Setup> 
<Setup></Setup> 
<Setup></Setup> 

</PolarXML> 
 
While the above is interesting, it’s not very useful; it does however show the main 
sections of the simple XML format employed. 

PolarXML Tag – this contains all of the data needed for the file. Only one PolarXML 
tag pair is expected in the source file. 

Header Tag – this contains one off header information for the file such as ‘Customer 
Name’. Only one Header tag pair is expected in the source file. 

Setup – this contains the data required for each test, multiple Setup tag pairs are 
expected, one for each test step in the final .cif test file. 

The following documents the optional tags that can be present in the Header section and 
the Setup section and how they function. 

The order that tags are within a section is not relevant, generally if a tag is not present 
then a default of some kind will be used. 

All strings ARE case sensitive – so ‘TRUE’ is not the same as ‘True’ or ‘true’ 
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Header Section Tags 
<Customer>XXXYYYZZZ</Customer> Text found in this tag will be put into the 
Customer Name field of the Board Details in the final file. 

<BoardType>XXXYYYZZZ</BoardType> Text found in this tag will be put into the Board 
Type field of the Board Details in the final file. 

<PartNumber>XXXYYYZZZ</PartNumber> Text found in this tag will be put into the 
Part Number field of the Board Details in the final file. 

<RevisionNumber>XXXYYYZZZ</RevisionNumber> Text found in this tag will be put 
into the Revision Number field of the Board Details in the final file. 

<Notes>XXXYYYZZZ</Notes> Text found in this tag will be put into the Notes field of 
the Board Details in the final file. This may be a multiline entry; i.e. the following is 
allowed: 

<Notes> 

Line1  

Line2 

Line3 
</Notes> 
<DebugFilePath>C:\xxx\yyy\zzz.txt</DebugFilePath> An optional fully qualified file 
path to a target text file that can be written to for debug purposes by the input XML 
reader in the CITS. 

<TargetFilePath>C:\xxx\yyy\zzz.txt</TargetFilePath> An optional fully qualified file 
path to a target file .cif file to be generated. If this tag is not present then the generated 
.cif file will be generated in the same directory as the source XML file and have the 
same filename.  

i.e. if the source XML file is C:\junk\input.xml and this tag is not found then the generated 
cif file will be found at C:\junk\input.cif 

Setup Section Tags 
There may be multiple Setup pair tags, one for each item in the final test list. If a tag 
pair is not present then the default value from the default test specified by hitting the 
Edit Default Test button found on the Utilities\ Config \ General Tab will be used. 

The following tags can be present in the Setup Section, they generally map to the 
functionality and fields of the same name in the Test Editor. 

<Description>xxxyyyzzz</Description>  
Text Field 

<Layer>xxxyyyzzz</Layer>  
Text Field 
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<Impedance>nn.nn</Impedance> 
Numeric Floating point value in Ohms, Minimum 0.10, Maximum 250.00 

<TestMethod>xxxx</TestMethod>  
Text Field, two options are supported 

Absolute Average 
<HorizontalUnits>xxxx</HorizontalUnits> 
Text Field, nominates the horizontal units employed, options are:  

Feet 
Inches  
Metres  
Millimetres  
Nanoseconds  
Picoseconds  
Seconds 

<ProbeLength>nn.nn</ProbeLength> 
Numeric Floating point value - Probe Length in nominated units 

<TestFrom>nn.nn</TestFrom> 
Numeric Floating point value - Test To Length in nominated units 

<TestTo>nn.nn</TestTo> 
Numeric Floating point value - Test To Length in nominated units 

<VP>0.66</VP> 
Numeric Floating point value – Minimum 0.33, Maximum 0.99 

<TolerancePlus>nn.nn</TolerancePlus> 
Numeric Floating point value – Test Tolerance Plus in percent Minimum 0.00, Maximum 
99.00 

<ToleranceMinus>nn.nn</ToleranceMinus> 
Numeric Floating point value – Test Tolerance Minus in percent Minimum 0.00, 
Maximum 99.00 

<TolerancePlusOhms>nn.nn</TolerancePlusOhms> 
Numeric Floating point value – Test Tolerance Plus in Ohms Minimum 0.00, Maximum 
99.00 
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<ToleranceMinusOhms>nn.nn</ToleranceMinusOhms> 
Numeric Floating point value – Test Tolerance Minus in Ohms Minimum 0.00, Maximum 
99.00 

<TestType>xxx</TestType> 
Text Field, supported options are :-  
Single Ended 
Differential  
Groundless Differential 

<ChannelSelection>nn</ChannelSelection> 
 Text Field, supported options are: 
For Single Ended and Groundless Differential  

CH1 
CH2 
CH3 
CH4 

For Differential 
CH12  
CH34 

<VerticalScale>nn</VerticalScale> 
Vertical scale in Ohms per division, options are :-  

50 
20 
10 
5 
2 
1 

<DifferentialUnbalanceWarningLimit>nn.n</DifferentialUnbalanceWarningLimit> 
Numeric Floating point value – if the value is <=0.0 or > 99.9 then Differential Unbalance 
is turned OFF 

<DCResistanceCompensation>xxx</DCResistanceCompensation>  
Text Field, Indicates if DC Compensation is employed: options are 

Default  
LossUser 
LossNormalized 
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<DCResistanceStart>nn.nn</DCResistanceStart> 
Start point for DC Resistance Compensation in distance units previously specified 

<DCResistanceOhms>nn.nn</DCResistanceOhms> Resistance in Ohms per unit 

<LPEP1Enable>xxxx</LPEP1Enable> 
Text Field, FALSE disables LPEP1, TRUE enables 
LPEP1<LPEP1Impedance>nn.nn</LPEP1Impedance> 
Numeric Floating point value in Ohms, Minimum 0.10, Maximum 250.00 

<LPEP1TolPlus>nn.nn</LPEP1TolPlus> 
Numeric Floating point value – Test Tolerance Plus in percent Minimum 0.00, Maximum 
99.00 

<LPEP1TolMinus>nn.nn</LPEP1TolMinus> 
Numeric Floating point value – Test Tolerance Plus in percent Minimum 0.00, Maximum 
99.00 

<LPEP1TolPlusOhms>nn.nn</LPEP1TolPlusOhms> 
Numeric Floating point value – Test Tolerance Plus in Ohms Minimum 0.00, Maximum 
99.00 

<LPEP1TolMinusOhms>nn.nn</LPEP1TolMinusOhms> 
Numeric Floating point value – Test Tolerance Plus in Ohms Minimum 0.00, Maximum 
99.00 

<LPEP1Distance>nn.nn</LPEP1Distance> 
Numeric Floating point in units previously specified, distance to LPEP1 

<LPEP2Enable>xxx</LPEP2Enable> 
Text Field, FALSE disables LPEP2, TRUE enables LPEP2 

<LPEP2Impedance>nn.nn</LPEP2Impedance> 
Numeric Floating point value in Ohms, Minimum 0.10, Maximum 250.00 

<LPEP2TolPlus>nn.nn</LPEP2TolPlus> 
Numeric Floating point value – Test Tolerance Plus in percent  
Minimum 0.00, Maximum 99.00 

<LPEP2TolMinus>nn.nn</LPEP2TolMinus> 
Numeric Floating point value – Test Tolerance Plus in percent  
Minimum 0.00, Maximum 99.00 

<LPEP2TolPlusOhms>nn.nn</LPEP2TolPlusOhms> 
Numeric Floating point value – Test Tolerance Plus in Ohms Minimum 0.00, Maximum 
99.00 

<LPEP2TolMinusOhms>nn.nn</LPEP2TolMinusOhms> 
Numeric Floating point value – Test Tolerance Plus in Ohms Minimum 0.00, Maximum 
99.00 
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<LPEP2Distance>nn.nn</LPEP2Distance> 
Numeric Floating point in units previously specified, distance to LPEP2 

<StructureNumber>nID</StructureNumber> Numeric, Options currently supported are 

nID Structure Differential 

0 Empty FALSE 
11 Surface Microstrip 1B FALSE 
12 Surface Microstrip 2B FALSE 
22 Embedded Microstrip 1B1A FALSE 
23 Embedded Microstrip 2B1A FALSE 
24 Embedded Microstrip 2B2A FALSE 
25 Embedded Microstrip 1B2A FALSE 
32 Offset Stripline 1B1A FALSE 
33 Offset Stripline 2B1A FALSE 
34 Offset Stripline 2B2A FALSE 
35 Offset Stripline 1B2A FALSE 
51 Coated Microstrip 1B FALSE 
52 Coated Microstrip 2B FALSE 
55 Dual Coated Microstrip 1B FALSE 
56 Dual Coated Microstrip 2B FALSE 
64 Embedded Microstrip 1E1B1A FALSE 
65 Embedded Microstrip 1E1B2A FALSE 
111 Edge-Coupled Surface Microstrip 1B TRUE 
112 Edge-Coupled Surface Microstrip 2B TRUE 
122 Edge-Coupled Embedded Microstrip 1B1A TRUE 
123 Edge-Coupled Embedded Microstrip 2B1A TRUE 
124 Edge-Coupled Embedded Microstrip 2B2A TRUE 
125 Edge-Coupled Embedded Microstrip 1B2A TRUE 
127 Edge-Coupled Embedded Microstrip 1B2A1R TRUE 
128 Edge-Coupled Embedded Microstrip 1B1A1R TRUE 
129 Edge-Coupled Embedded Microstrip 2B1A1R TRUE 
132 Edge-Coupled Offset Stripline 1B1A TRUE 
133 Edge-Coupled Offset Stripline 2B1A TRUE 
134 Edge-Coupled Offset Stripline 2B2A TRUE 
135 Edge-Coupled Offset Stripline 1B2A TRUE 
137 Edge-Coupled Offset Stripline 1B1A1R TRUE 
138 Edge-Coupled Offset Stripline 2B1A1R TRUE 
139 Edge-Coupled Offset Stripline 1B2A1R TRUE 
151 Edge-Coupled Coated Microstrip 1B TRUE 
152 Edge-Coupled Coated Microstrip 2B TRUE 
155 Edge-Coupled Dual Coated Microstrip 1B TRUE 
156 Edge-Coupled Dual Coated Microstrip 2B TRUE 
164 Edge-Coupled Embedded Microstrip 1E1B1A TRUE 
165 Edge-Coupled Embedded Microstrip 1E1B2A TRUE 
194 Edge-Coupled Embedded Microstrip 2B2A1R TRUE 
211 Surface Coplanar Waveguide With Lower Gnd 1B FALSE 
212 Surface Coplanar Waveguide With Lower Gnd 2B FALSE 
222 Embedded Coplanar Waveguide With Lower Gnd 1B1A FALSE 
223 Embedded Coplanar Waveguide With Lower Gnd 2B1A FALSE 
232 Offset Coplanar Waveguide 1B1A FALSE 
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233 Offset Coplanar Waveguide 2B1A FALSE 
234 Offset Coplanar Waveguide 1B2A FALSE 
235 Offset Coplanar Waveguide 2B2A FALSE 
251 Coated Coplanar Waveguide With Lower Gnd 1B FALSE 
252 Coated Coplanar Waveguide With Lower Gnd 2B FALSE 
255 Dual Coated Coplanar Waveguide With Lower Gnd 1B FALSE 
256 Dual Coated Coplanar Waveguide With Lower Gnd 2B FALSE 
311 Diff Surface Coplanar Waveguide With Lower Gnd 1B TRUE 
312 Diff Surface Coplanar Waveguide With Lower Gnd 2B TRUE 
322 Diff Embedded Coplanar Waveguide With Lower Gnd 1B1A TRUE 
323 Diff Embedded Coplanar Waveguide With Lower Gnd 2B1A TRUE 
332 Diff Offset Coplanar Waveguide 1B1A TRUE 
333 Diff Offset Coplanar Waveguide 2B1A TRUE 
334 Diff Offset Coplanar Waveguide 1B2A TRUE 
335 Diff Offset Coplanar Waveguide 2B2A TRUE 
351 Diff Coated Coplanar Waveguide With Lower Gnd 1B TRUE 
352 Diff Coated Coplanar Waveguide With Lower Gnd 2B TRUE 
355 Diff Dual Coated Coplanar Waveguide With Lower Gnd 1B TRUE 
356 Diff Dual Coated Coplanar Waveguide With Lower Gnd 2B TRUE 
411 Surface Coplanar Strips With Lower Gnd 1B FALSE 
412 Surface Coplanar Strips With Lower Gnd 2B FALSE 
422 Embedded Coplanar Strips With Lower Gnd 1B1A FALSE 
423 Embedded Coplanar Strips With Lower Gnd 2B1A FALSE 
432 Offset Coplanar Strips 1B1A FALSE 
433 Offset Coplanar Strips 2B1A FALSE 
434 Offset Coplanar Strips 1B2A FALSE 
435 Offset Coplanar Strips 2B2A FALSE 
451 Coated Coplanar Strips With Lower Gnd 1B FALSE 
452 Coated Coplanar Strips With Lower Gnd 2B FALSE 
455 Dual Coated Coplanar Strips With Lower Gnd 1B FALSE 
456 Dual Coated Coplanar Strips With Lower Gnd 2B FALSE 
511 Diff Surface Coplanar Strips With Lower Gnd 1B TRUE 
512 Diff Surface Coplanar Strips With Lower Gnd 2B TRUE 
522 Diff Embedded Coplanar Strips With Lower Gnd 1B1A TRUE 
523 Diff Embedded Coplanar Strips With Lower Gnd 2B1A TRUE 
532 Diff Offset Coplanar Strips 1B1A TRUE 
533 Diff Offset Coplanar Strips 2B1A TRUE 
534 Diff Offset Coplanar Strips 1B2A TRUE 
535 Diff Offset Coplanar Strips 2B2A TRUE 
551 Diff Coated Coplanar Strips With Lower Gnd 1B TRUE 
552 Diff Coated Coplanar Strips With Lower Gnd 2B TRUE 
555 Diff Dual Coated Coplanar Strips With Lower Gnd 1B TRUE 
556 Diff Dual Coated Coplanar Strips With Lower Gnd 2B TRUE 
611 Surface Coplanar Waveguide 1B FALSE 
612 Surface Coplanar Waveguide 2B FALSE 
622 Embedded Coplanar Waveguide 1B1A FALSE 
623 Embedded Coplanar Waveguide 2B1A FALSE 
651 Coated Coplanar Waveguide 1B FALSE 
652 Coated Coplanar Waveguide 2B FALSE 
711 Diff Surface Coplanar Waveguide 1B TRUE 
712 Diff Surface Coplanar Waveguide 2B TRUE 
722 Diff Embedded Coplanar Waveguide 1B1A TRUE 
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723 Diff Embedded Coplanar Waveguide 2B1A TRUE 
751 Diff Coated Coplanar Waveguide 1B TRUE 
752 Diff Coated Coplanar Waveguide 2B TRUE 
811 Surface Coplanar Strips 1B FALSE 
812 Surface Coplanar Strips 2B FALSE 
822 Embedded Coplanar Strips 1B1A FALSE 
823 Embedded Coplanar Strips 2B1A FALSE 
851 Coated Coplanar Strips 1B FALSE 
852 Coated Coplanar Strips 2B FALSE 
911 Diff Surface Coplanar Strips 1B TRUE 
912 Diff Surface Coplanar Strips 2B TRUE 
922 Diff Embedded Coplanar Strips 1B1A TRUE 
923 Diff Embedded Coplanar Strips 2B1A TRUE 
951 Diff Coated Coplanar Strips 1B TRUE 
952 Diff Coated Coplanar Strips 2B TRUE 
1111 Edge-Coupled Surface Without Gnd 1B TRUE 
1112 Edge-Coupled Surface Without Gnd 2B TRUE 
1122 Edge-Coupled Embedded Without Gnd 1B1A TRUE 
1123 Edge-Coupled Embedded Without Gnd 2B1A TRUE 
1125 Edge-Coupled Embedded Without Gnd 1B2A TRUE 
1132 Broadside Stripline 2S TRUE 
1133 Broadside Stripline 3S TRUE 
1134 Broadside Stripline 1E2S TRUE 
1135 Broadside Stripline 1E3S TRUE 
1136 Broadside Without Gnd 2S TRUE 
1151 Edge-Coupled Coated Without Gnd 1B TRUE 
1152 Edge-Coupled Coated Without Gnd 2B TRUE 

Example Files and Output 

In the same directory as this document should be an example input XML file called 
Test.xml and an example output debug file called XMLImportDebug.txt. 

The final file that they generate called TestXML.cif is also included. 

Please send any questions / feedback to PolarCare@polarinstruments.com 

mailto:PolarCare@polarinstruments.com
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